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Chapter 1

Using ImposeMate

Introduction

Imposition is the arrangement of pages on the plate in such a way that the pages
appear in the correct reading order after printing, folding and binding. The actual
arrangement of the pages on the medium depends on many factors: the size of the
printing press, the binding method, the number of pages in the publication, the fold-
ing and binding equipment etc.

Manual imposition is a complicated and time-consuming process where the films for
the individual pages are cut out and taped to a bearer material in the correct order and
orientation. For color jobs or large books, the page arrangement schemes are very
complicated and consequently the risk of making an error is high. The introduction of
electronic imposition programs has eliminated most of the tiresome, repetitive steps
in imposition. But still the process consists of many steps and can take a long time,
especially with large files.
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Chapter 1 « Using ImposeMate
Introduction

ImposeMate speeds up the process by eliminating many of the usual steps in an
imposition workflow. Also, the actual imposition of pages is not performed on the
workstation, but in the RIP itself, which also speeds up the process significantly.

Using ImposeMate you can create
“impositions”, i.e. page features with
an imposition layout. Once the layout
of the imposition page feature is
specified and saved in the RIP, the
pages will flow into the correct posi-
tions on the media whenever you
print to the specific imposition page
feature.

ImposeMate can be run as a stand-alone
program on the WorkMates PC or
remotely via the ImposeMate Client pro-
gram. This manual documents the stand-
alone program. WorkMates User Guide
AG50664 documents the client program.

Using the imposition page features is very productive for repeat jobs such as weekly
or monthly magazines that can use the same imposition page feature over and over

again.

IMPOSITION TYPES IN IMPOSEMATE

The ImposeMate imposition tool lets
you create 2-up to 16-up imposition
page features with automatic page
numbering and page order. This "n-
up™ or N x N imposition type works
with PDF files. Optionally, the "n-
up" imposition page features can
include work styles such as Sheet-
wise and Perfector and binding meth-
ods such as Perfect Bound and
Saddle Stitched including compensa-
tion for creep (shingling). For more
details, see the sections on “Work
styles” on page 10, “Binding styles”
on page 11 and “Shingling (creep)”
on page 12.

There are five variations of ImposeMate.

» ImposeMate (the full version) supports
unlimited imposition size.

» ImposeMate News supports impositions
up to 25.0" x 36.5.1" (632 x 927).

e ImposeMate DPX2 supports imposi-
tions up to 21.6" x 18.1" (550 x 460).

» ImposeMate DPP supports impositions
up to 12.9" x 47.21" (328 x 1200).

» ImposeMate 2020 supports impositions
up to 13.3" x 47.21" (340 x 1200).
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Chapter 1 « Using ImposeMate

Plan your imposition

Another imposition type using PDF files is Step’n Repeat. You can use this imposi-
tion type for stepping and repeating a single page PDF or you can combine several
PDF files in a step and repeat job using the RunList editor.

In addition, ImposeMate offers imposition types which fill either a row, column or an
entire film, while rotating pages in the RIP to save film or plate material. These
imposition types work with PDF or PostScript files.

See also:

e “Plan your imposition” on page 7

e “Enabling ImposeMate” on page 14

» “Starting and exiting ImposeMate” on page 16

e “ImposeMate overview” on page 17

Plan your imposition

Properly planning your imposition job can save you a lot of trouble and minimize
production time and costs.

First make sure that you have all the information you will need to produce the job,
including:

» number of pages in the publication

« imposition layout (number of pages, page order and orientation on the press
sheet)

 binding and folding method
 printing method and required screen type
* location of high resolution images, if any

e etc.

WorkMates ImposeMate User Manual, AG50663 Rev. 11 7



Chapter 1 « Using ImposeMate
Plan your imposition

After you collect all the necessary information, you should make a “folding dummy”
(a representation of the folded press sheet). The folding dummy actually shows you
how pages how pages must be ordered and oriented in the imposition.

To create a folding dummy, fold a blank sheet of paper into half and repeat this until
you have the required number of pages per press sheet. While the paper is folded,
mark the page numbers on each page.

Figure 1.1 Folding dummy

8 WorkMates ImposeMate User Manual, AG50663 Rev. 11



Chapter 1 « Using ImposeMate
Plan your imposition

After unfolding the paper, you will see the imposition layout, complete with page
order and orientation.

Figure 1.2 Imposition layout

If the imposition layout of the first press sheet (front and back side) is going to be
used for all press sheets in the publication, it is not necessary to specify more than the
imposition layout for the first press sheet. The RIP will automatically generate the
required signatures (see also “Flat and Press Sheet” on page 10) to accommodate all
pages in the publication. This way you can, for example, use an imposition page fea-
ture for a 16 page perfect bound publication to produce 32-page, 48-page, 64-page
etc. publications as well.

WorkMates ImposeMate User Manual, AG50663 Rev. 11 9



Chapter 1 « Using ImposeMate
Plan your imposition

Flat and Press Sheet

A complete press sheet, front and back, and corresponds to two flats.

Front Flat Back Flat
b b b
16 1 4
g g 5
| | |

& [ b [ b [
16 1 4 13
15 2 3 14
| g = 12
wof Y7 H el H o

Figure 1.3 Sheetwise Press Sheet

Signature

A signature is a printed press sheet that is folded one or more times to form a single
unit of several pages in multiples of four.

ImposeMate lets you define signature constructs like the order and orientation of the
pages in the signature, work style, binding style, and bleed. For more details, see
“ImposeMate overview” on page 17

Work styles
Using ImposeMate you can create imposition page features for printing press work
styles such as perfector and sheetwise.

PERFECTOR

Perfector is a work style used for sheet fed printing presses that prints both sides of
the press sheet in one pass. When the first side has been printed using one plate the
press sheet is automatically tumbled end over end on the horizontal axis, before the

10 WorkMates ImposeMate User Manual, AG50663 Rev. 11



Chapter 1 « Using ImposeMate
Plan your imposition

second side of the sheet is printed using another plate, now with the tail of the press
sheet facing the gripper on the press.

SHEETWISE

Sheetwise is a work style that prints the
first side of the press sheet using one plate,
then the sheet is flipped left to right, before
the second side of the sheet is printed using
another plate.

Perfector and SheetWise work in
conjunction with the gripper edge.

CUSTOM
Pages are placed manually in the flat.

See also “Imposition type N x N Imposition” on page 36.

Binding styles

Using ImposeMate you can create impaosition page features for binding styles such as
saddle stitched and perfect bound.

SADDLE STITCHED PUBLICATIONS

In saddle-stitched publications the folded signatures are inserted inside one another
before they are bound together, usually by stapling and cut as a book.

Figure 1.4 Saddle Stitched binding style
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Chapter 1 « Using ImposeMate
Plan your imposition

PERFECT BOUND PUBLICATIONS

In perfect bound publications the folded signatures are stacked on top of each other
before they are bound together on a common edge, usually by glue and cut as a book.

Figure 1.5 Perfect Bound binding style

See also “Imposition type N x N Imposition” on page 36.

Shingling (creep)

Shingling is the process of moving the image area on pages in an imposition layout to
avoid creep.

Creep occurs when imposed signatures are folded and the image area of the inside
pages extends beyond the image area of the outside pages. How much depends on the
number of folds and the paper thickness used.

—_—

Figure 1.6 Creep: inside pages extend outside pages
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Chapter 1 « Using ImposeMate
Plan your imposition

CREEP IN SADDLE STITCHED PUBLICATIONS

In saddle stitched publications each folded signature is placed inside another folded
signature, and the increased thickness of the fold causes the inside signatures to
extend the outer signatures slightly. Consequently, creep may occur on page level
inside the individual signature and on signature level between the folded signatures
that are placed inside each other to be assembled as a book.

CREEP IN PERFECT BOUND PUBLICATIONS

In perfect bound publications creep is limited to the pages in the individual signature.
The folded signatures are stacked on top of each other before they are bound and cut
as a book.

COMPENSATION FOR CREEP

To compensate for the creep you apply
shingling to your imposition. Shingling
moves the image area on a page toward the
direction you specify. For example, shin-
gling can be specified to move the image
area either away from or toward the binding. The image area on a page in the imposi-
tion layout is moved in relation to its preceding page.

ImposeMate’s shingling works best
with signatures that reflect standard
folding conventions.

ImposeMate will automatically apply correct shingling depending on the selected
binding method, for more details on applying, see “Creep section N x N Imposition”
on page 43.

In saddle stitched publications ImposeMate spreads the shingling adjustment across
all signatures in the imposition layout. In perfect bound publications ImposeMate
applies the amount of the shingling adjustment to each signature, and each signature
is the same.

WorkMates ImposeMate User Manual, AG50663 Rev. 11
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Chapter 1 « Using ImposeMate
Enabling ImposeMate

Enabling ImposeMate

Note: The Macintosh-based ImposeMate program resembles the Windows-based
ImposeMate program as much as possible, taking the necessary differences in the
overall design of the two platforms into consideration. This manual describes
ImposeMate running on the Windows platform. Differences are only described, when
they influence the use of the program.

To enable ImposeMate you need to purchase a license key number from your sup-
plier, and then enter the number in the license setup utility.

To enable ImposeMate:

1+ On Windows click Start > Programs > "ECRM WorkMates" > ImposeMate
program icon to open ImposeMate.
Note: If you have installed ImposeMate in a program folder of its own, you
open the program from the ImposeMate program folder.

2 » On Mac double-click the ImposeMate icon in the RIP folder to open Impose-
Mate.
%
ImposeMate

Figure 1.7 ImposeMate icon Macintosh
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Chapter 1 « Using ImposeMate
Enabling ImposeMate

3+ The ImposeMate window opens.

@ ImposeMate Standalone - Untitled IZ@JB‘

File Edit Imposition Help
i Runlist || 1mposition | Marks | Freferences |
Files and Pages RurList Separations
F-RGCatalog0. pdf Order File Page Calor Separation

1|R&Catalogo.pdf 1 Cyan
2[RGCatalogd.pdf 2 I Magenita
3[RECatalog0.pdf 3 ellow
4[RGCatalog0.pdf 4 [ JEELN
SRGCatalogd.pdf |5

6RGCatalogd.pdt |6

7|RGCatalog0.pdf 7

BRGCatalogd.pdf |8

9RGCatalogd.pdf |3

10[RGCatalog0.pdf 10

11/RGCatalog0.pdF i1

12/RGCatalog0.pdF 12

13[RECatalog0.pdf 13

14/RGCatalog0.pdF 14

15/RGCatalog0.pdF 15

16RGCatalog0.pdt 16
[ [

outpLit
Narme ¢ |RGCatalog0_nunlst ps | use : Trmsize 5.75x8.75 inch
" owerride : [¥] Imposition Fage Layout siee [ ] Separation Style
imaging systems e
o [Jscaling  Horzontal 100 | % Vertical |10 |% [Jrotate |0
[ resolution dpi []Frequency Ipi

Figure 1.8 ImposeMate window

e Anupgrade installation based on the old ImposeMate dongle will reuse
the license number and the ImposeMate dongle.

¢ Anew installation will be based on the RIP dongle and ImposeMate may
ask for a license number for the dongle. The License Setup dialog opens:

License Setup

Flease enter the ImposeMate license string
for the dongle with serial number: 55588
(Hit "Cancel” to continue in DemoMode])

[l |

Figure 1.9 License Setup dialog
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Chapter 1 « Using ImposeMate
Starting and exiting ImposeMate

4 « Enter the license key number and click OK.
If you click Cancel ImposeMate will open in Demo mode allowing you to try
out the ImposeMate tool. The demo mode does not let you save any imposition
page features.

Starting and exiting ImposeMate

Important: You need to start the RIP once before you can use ImposeMate.

To start ImposeMate on Windows:

1+ Click Start > Programs > "RIP folder" > ImposeMate program icon.
Note: If you have installed ImposeMate in a program folder of its own, you
open the program from the ImposeMate program folder.

OR
2« Click the ImposeMate shortcut on the desktop, if you have created one.

3« The ImposeMate window opens ready to use.

To exit ImposeMate on Windows:

1+ Click the red Exit button in the upper right corner of the window.

To open ImposeMate on Macintosh:

1+ Double-click the ImposeMate icon in the RIP folder.

42’
ImposeMate

Figure 1.10 ImposeMate icon Macintosh

2 » The ImposeMate window opens ready to use.
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Chapter 1 « Using ImposeMate
ImposeMate overview

To quit ImposeMate on Macintosh:

1+ Click the red Quit button in the upper left corner of the window.

ImposeMate overview

The ImposeMate window contains a number of menus and tabs which are described
in detail in:

e “ImposeMate menus” on page 17

e “Creating RunLists” on page 22

e “Creating Impositions” on page 35

*  “WorkMates FolderWizard” on page 49
e “Adding Marks” on page 66

« “Defining Preferences” on page 78.

See also:
« “How to create an imposition page feature step by step” on page 91
* “How to use an imposition page feature” on page 92

e “Qutputting a Runlist file” on page 93.

ImposeMate menus

The ImposeMate menus contain commands to the functions described below.

WorkMates ImposeMate User Manual, AG50663 Rev. 11
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ImposeMate overview

IMPOSEMATE MENU (MACINTOSH ONLY)
ImposeMate,.
About ImposeMate
Services >

Hide ImposeMate #H
Hide Others 3#H

Show All

Quit ImposeMate #Q
Figure 1.11 ImposeMate menu (Mac only)

About ImposeMate
Use this command to open a dialog with information on the ImposeMate pro-
gram version.

Quit ImposeMate
Use this command to quit the program.

Note: Remaining commands are Macintosh platform related.

FILE MENU
Mew RunList Ctrl+n New RunList #EN
Mew Imposition Ctrl+Shift+M MNew Imposition {+3EN
Open File, . Chrl4+0 Open File... 3#£0
Open Imposition..,  Ctrl+Shift+0 Open Imposition... {+30
Save RuriList Ctrl+s Save RunList 35S
Save Runlist As... Save RunList As...
Save Imposition Chrl+5Shift+5 Save Imposition {+3ES
Save Imposition As... Save Imposition As...
Save Prefered Marks  Chrl+M
Show Info... Chrl4+-Shift+1 Save Prefered Marks il
" Show Info... i1 31

Figure 1.12 File menu:
New RunList

Use this command to create a new runlist.
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ImposeMate overview

New Imposition
Use this command to create a new impaosition page feature.

Open File
Use this command to open an existing runlist file or .pdf file.

Open Imposition
Use this command to open an existing imposition page feature.

Save RunList
Use this command to save a runlist.

Save RunList As
Use this command to save a runlist under a different name or folder.

Save Imposition

Use this command to save an imposition B
page feature. -
Note: Impositions are saved in the RIP’s
g FoniDl, =
\SW\Page Features folder. facoes é’:,L- e
3 colonmondrings =t J:t'-.—xn"..«—.
Lacolorspacns Cahalftones CafropFins
. o S et Slsprodxterts
Save Imposition As Scrigen S kreq Seereenn
D cevices Olsarmsat yScreen:
H - e ercodings Inputs. Separ ation Fea
Use this command to save an imposition S éx:m&wm éw
H . : »
page feature under a different name. e

Figure 1.13 Page Features Folder

Save Preferred Marks
Use this command to save your preferred marks in Preferences, ready for use the
next time you create a new imposition. You can save one set of marks for each of
the three imposition types: N x N, Step’n Repeat and Fill Column, Row or Film.

Show Info — RunList tab only
Use this command to display a dialog box with job information on a pdf file.

WorkMates ImposeMate User Manual, AG50663 Rev. 11
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ImposeMate overview

Exit (Windows only)
Use this command to exit the program.

EDIT MENU

The Edit menu reflects which tab is selected in the ImposeMate window.

Runlist Tab Imposition Tab
Marks Tab
Preferences Tab
Edit Help iEh_q-}He\p
Cut: Ciri CUt: Chrl+x
Corty Cirlte Copy. Cirhe
Paste Clrl+y Paste Cirk+y
Delete Delate Delete Deleta
Select Al Cirl+d Select Al Cirk+a
Select None Ctr+Shift+a Select None CirhShift+a
Cpen Thurmbnail Yiew ... Ciri+l Cpen Thumbnail Yiew ... Cri+U
Open izard... Cirh-altN
Turn Page CW Cr+T
Turn Page CCW CirHShift+T
Turn Sheet CWA AT
Turn Sheet CCA Alt+ShifthT

Figure 1.14 Edit menu

Cut, Copy, Paste, Delete — all tabs
Use these commands for the standard functions cut, copy, paste and delete.

Select All — all tabs
Use this command to select, for example, all pages in the Imposition tab’s Lay-
out section.

Select None — all tabs
Use this command to deselect.

Open Thumbnail View...— all tabs
Use this command to select a thumbnail view of the imposed flat.

Open Wizard — Imposition tab only
Use this command to open the WorkMates Folder Wizard.
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ImposeMate overview

Turn Page CW — Imposition tab only
Use this command to rotate selected pages in the Layout section clockwise 90
degrees.

Turn Page CCW - Imposition tab only
Use this command to rotate selected pages in the Layout section counter clock-
wise 90 degrees.

Turn Sheet CW — Imposition tab only
Use this command to rotate sheets in the Layout section clockwise 90 degrees.

Turn Sheet CCW — Imposition tab only
Use this command to rotate sheets in the Layout section counter clockwise 90
degrees.

IMPOSITION MENU

Irmp
Add to Favorites Crl+D
Organize Fawvorites... Cirl+Shift+0r |

Figure 1.15 Imposition menu

Add to Favorites
Use this command to add an imposition to your Favorites list.

Organize Favorites...
Use this command to open the Manage Favorites window, which allows you to
to create, delete and manage subfolders for grouping favorite impositions.
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HELP MENU
IHeIp [}3
Help F1
WiorkMates online. ..
About
Figure 1.16 Help menu
Help

Use this command to open the ImposeMate Help. Required is Internet Explorer
5.0 or later with JavaScript enabled or similar browser, for example Mozilla Fire-
fox 1.x or Safari 1.x and 2.x.

Note: Help screens are not included in the current release of ImposeMate.

Workmates online...
Use this command to open an Internet connection with the ECRM Web site and
then navigate to the Support area.

About (Windows only)

Use this command to open a dialog with information on the ImposeMate pro-
gram version.

Creating RunLists

When you start ImposeMate the program opens with the RunList editor tab in front.
ImposeMate’s RunList editor lets you insert, delete, replace or swap pages in PDF
files and save the result as a runlist in PostScript format. The runlist displays the page
order in which pages will flow into position when used in an imposition page feature.

You can use the RunList editor to assemble pages in a publication or carry out last
minute corrections before output. See “Outputting a Runlist file” on page 93.

The RunList tab contains the following sections:

» Files and Pages list

22 WorkMates ImposeMate User Manual, AG50663 Rev. 11



Chapter 1 « Using ImposeMate

Creating RunLists

— lists the PDF files (and their pages) that have been added to the list.

* Runlist

— displays the page order, file names and page numbers in the runlist that has

been created from the PDF files in the Files and Pages list.

o list

— displays the colors and separations used in the PDF file(s) that are in the Files

and Pages list.

e Output section

— contains Runlist output options.

@ ImposeMate Standalone - Untitled

t Imposition

dit Imposition  Help

| Marks | Preferences

L EX

es and Pages

RunList

[ RGECakalog0. pdf

Order File Page
RGCatalog0.pdf

Separations

Color

RGCatalogd.pdf

RGCatalog0.pdf

RGCatalog.pdf

RGCatalog.pdf

1
2|
3
4
5|RGCatlog0.pdF
&
7
g

RGCatalogn.pdf

RGCatalog0.pdf

o o T

9[RGCatalogD.pdf

10[RGCatalog0.pdf 10

11|RGCatalogd.pdf i1

12[RGCatalogo.pdf 12

13[RGCatalogd.pdf i3

14[RGCatalog0.pdf 14

15[RGCatalogD.pdf 15

16/RGCatalogd.pdf 16

o |
vellow
I

Separatio
Cyan

n

Magenta

Black

>

imaging systems

Output

MName :

Override :

|RGCatalog_runiist ps

‘ Use : Trim Size

[#] tmposition e Layout
[ scaling Horizontal |0 | 9
[JResolution | | dpi

2= []Separation Style

Vertical | 101 |9 [rotate

[ Frequency

5,75 x 8.75 inch

T

Note: When working in the RunList editor make sure that you use PDF files with the

Figure 1.17 RunList tab

same page size and page numbering when creating or editing a Runlist.

For more information, see “Creating a Runlist” on page 24 and “Outputting a Runlist

file” on page 93.
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Creating a Runlist

When you open ImposeMate and select the RunList tab, the Files and Pages list and
the Runlist are empty.

To create a Runlist:

1+ Note: If you have been working in ImposeMate and you want to create a new
runlist, select New RunList from the File menu and proceed as follows.

1+ Select Open File from the File menu.
This opens a dialog that lets you:
«  browse for a PDF file to select and add to the Files and Pages list.
« open an existing Runlist file for editing.

Look in: |@ Div PS_PDF filer V| E -:,lElEl

&

T BapinA Admin30-uk et
My Recert | 5E) ki 2-0utput poi

Documents T Ch 4-Cresteontage pof

= -',"_-. Ch.5-AszemblePages pdf
@ T Chked poit
Deskiop T Copy of ChYK+4 pof
-',"_-. Copy of ferrari pdf
-',"_-. ferrari newy rear pof

-',"_-. ferrari pf

-

Wy Documents = ParaplyPige2 pof
-',"_-. pracolorsdpad pof
- 7'_—- oxpdpagecolors podf
._1)1)3 -',"_-. TechSpecOddhumbers pof

My Computer -',"_-. Testdokumert pdf

H-)] File name: | 1Epages_oddnumbered pof |
My Metweork
Places Files of type: |pDF Files: [ pof) L3 | Cancel

Figure 1.18 Open dialog

2« To open an existing Runlist file, select a —runlist.ps file and click Open. This
will open the Runlist file in the RunList editor.
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3« Select a PDF file and click Open.This will add the file to the Files and Pages
list.
Or, Alternatively, drag one or more PDF files onto the Files and Pages list or to
the RunList section.

@)‘ ImposeMate Standalone - Untitled D@”z

Fle Edit Impositon Help
| RunList \ Imposition | Marks | Preferences |
Files and Pages RunList Separations
B pxpdpagecolors pdf | Order File Page Color Separation
1 | 1|qxp4pagecolors.pdl 1 Cyan
2 2|arptpagecolors.pdt 2 N Magenta
3 3lgxpdpagecolors.pdf |3 il
4 4|qxpdpagecolors pdf |4 | NMEIE=N
Qutaut
Mame : Laxpdpagecolors_tunlist ps | Use | Media Size l‘ 20,32 % 29,67 cn
ECRMQ Cverride : Imposition Fage Layout size [ Separation Style
imaging systems o 1
. [Scaling  Horizontal [ 100 % vertical |10 [% [Jrotte
[ Resolution J dpi [ Frequency J Ipi

Figure 1.19 RunList editor

When creating a new Runlist the first PDF file added to the Files and Pages list
will automatically have all pages listed in the RunL.ist section, and all colors
used in the PDF listed in the Separations section.

When you open an existing Runlist file all PDF files, pages and colors used for
creating the Runlist are listed.
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4« Add pages to the Runlist.
Select one or more files or pages from the Files and Pages list, then drag and
drop them on the empty line below the last page in the Runlist.

In the Files and Pages list:
e Click the expand symbol to expand the file and see the pages.
*  Click the file name to select the file and all pages in the file.

e Ctrl-click (cmd-click on Mac) the page number to select pages discontin-
uously.

«  Shift-click to multi-select/deselect pages continuously.

e Select a file or page, then right-click (ctrl-click on Mac) to open a menu
that lets you Cut, Copy, Paste, Select All and Deselect All, — using com-
mands or shortcuts.

@ ImposeMate Standalone - Untitled r_ |
File Edit Impositon Help
| | Imposition | Marks | Preferences
Files and Pages RunList Separations
= gepapagecolors pof | | |[Orcer File Pane M| comr Separation
4 1 |gxpdpagecolors pof 1 Cyén
: Diptigegeoos i, 3  E— ogerta
3 3|gxpdpagecolors pof 3 @Iow
4 _——_—? 4 |gxpdpagecolors pof 4 — B
= 16pages_oddnumbered, 7 Green
i I [Red A
1 1
1 il
1w
2a
2h
20 =
2d
P
i 4]
Output
Nare ¢ L3xpdpagecolors_tunlist ps | Use : Media Size V| 2032x2867¢
ECRM’ Cvarride Imposition “age Layout size [ | Separation Style
imaging systems : i == = |
shin sl sl [ 5caling Harizartal | 100 |% Vert\cali 0C | % [ JRotate
I:‘ Resolution | |dp\ D Frequency | |Ipi Save

Figure 1.20 Files and Pages list
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The RunList editor will recognize various page numbering styles created in, for
example QuarkXPress, and display the numbering style in both lists.

Note: The RunList editor will let you mix any PDF page size, page numbering
sequence and numbering style in a Runlist which in most cases would be
unsuited for production. Therefore, make sure to create or edit the Runlist using
PDF files with the same page size, and continuous page numbering and style, if
you want a consistent PostScript file for output.

However, in ImposeMate you can set a page tolerance value to determine how
big the difference in page size can be before a job errors. For details, see “Cre-
ating Impositions” on page 35.

Rearrange the page order in the Runlist.

In the Runlist:

e The Order column lists the order in which the page will flow into posi-
tion in the imposition layout.

e The File column shows the name of the file from which the page origi-
nates.

e The Page column shows the page number (and numbering style) of the
page in question.

o Select one or more pages, then right- ===

RurlList Separations
click (ctrl-click on Mac) to open a Or.. Fis page]] | [€.] separatbon | .. T
| 1jp75x500B.11 [Cyan v | |w
menu that lets you Cut, Copy, Paste __g};;g;g;gg 2.p e 2R
13,75 % 5. lack v | |
and Delete a page or sort pages — el
6i3.75x5008.6
using commands or shortcuts (see [ EreEle. g
. : I S
figure at right). COW s
. Paste Chrl+P
Select a page and drag it up or down to Dekee Dekere
. Insert Blank Page
rearrange page order. The page will move :
to the position above the page the cursor Sort by Flenzme
. Sort by Title
p0| ntS at. Sort by Page
[
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RunList

Order File: Page
1 |gxpdpagecolors pdf 1
2|gxpdpagecolors pdf 2
3 |gxpdpagecolors pdf 3
4 |gxpdpagecolors pdf 4
5|16pages_oddnumbered pdf
6 |1Gpages_oddnumbered pdf
7

1 Bpages_oddnumbered pof
g1 cdhumbered pof
91 Bpages_oddnumbered pdf
101 6pages_oddnumbered pdf
11 [16pages_oddnumbered pdf
12[16pages_oddnumbered pdf

Figure 1.21 Drag page to new position in Runlist

RunList
Order File: Page
1 |gxpdpagecolors pdf 1
2|gxpdpagecolors pdf 2
3 |gxpdpagecolors pdf 3
4 |gxpdpagecolors pdf 4
5|16pages_oddnumbered pdf 1w
6 |1Gpages_oddnumbered pdf 1w
71 Bpages—oddnumbered pet 1 vii
e 5 |16pages_oddnumbered pdf 2.d rd
91Bpages_oddnumbered pdf 1 il
101 6pages_oddnumbered pdf 2.a
11 [16pages_oddnumbered pdf 2h
12[16pages_oddnumbered pdf 2.c

Figure 1.22 Page repositioned

6« Add a blank page to the Runlist.
Select the empty line below the last page in the runlist (1), drag it to the wanted
position (2) and release the mouse button. The blank page will appear above the
page the cursor points at (3).
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RunList

Order File: Page
1 |gxpdpagecolors pdf 1
2|gxpdpagecolors pdf 2
3 |gxpdpagecolors pdf 3
4 |gxpdpagecolors pdf _

RunList

Creler

File
1 |gxpdpagecolors pdf

3|gxpdpagecolors pdi 3
4|gxpdpagecolors pdi 4
RunList
Creler File: Page
dpagecolors pof 1
b 2 Elank page

J[pdpagecoors pat

2z

4 |gxpdpagecolors pdf

3

5 |gxpdpagecolors pdf

4

Figure 1.23 Add blank page to Runlist

You can insert as many blank pages as you need, one at a time. You can rear-
range the order of blank pages just like any other page.

7« Insert a page in the Runlist.

Select a page from the Files and Pages list, press the Control key (Alt key on
Mac) while dragging it to the Runlist and drop it on a page.

The new page will be added below the page the cursor points at. Note that when
inserting the cursor displays a plus (+) sign.

Files and Pages

RunLizt

(= gxpdpagecolors pdf
1

16pages_oddhumbered pdf

Figure 1.24 Insert a page in Runlist

Order File
1[16pages_oddnumbered pdf

Page
1.

2[16pages_oddnumbered pdf

i

5

6l16panes_oddnurmbered gt 1.1
7 [16pages_oddnumbered pot 1 il
8[16pages_oddnumbered pdt 1 il
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~Files and Page: ~RunList
= gxp4pagecolors pof Order File Page
1 1 |16pages _oddnumberad pof 1.0
2 2|16pages_oddnumbered pof i
a 3/16pages_oddnumbered pof 1 il
" 4 4| pdpagecalors. podf 3 >
16pages_oddnumbered pof S[1Epages_oddnumbered pat v
E|16pages _oddnumberad pof 1w
7 |16pages _oddnumberad pof 1.
5|16pages _oddnumberad pof 1 il
916pages _oddnumberad pof 1 il

Figure 1.25 Page inserted

8 « Replace a page in the Runlist.
Select a page in the Files and Pages list, drag it onto a page in the Runlist and
drop it. The new page replaces the existing page.

rFiles and Page: RunList
= grpdpagecolors oot Crder File: Page
q 1|16pages _oddnumbered pof 1.0
2 2|16pages_oddnumbered pof i
a 3|1Bpa cldhunbered pdf
4 4
16pages_oddnumbered pdf 3/16pages_oddnumbered pdf 1w %3
E|16pages _oddnumbered pof 1.3
7 |16pages _oddnumbered pof 1 il
5|16pages _oddnumbered pof 1 il

Figure 1.26 Replace a page in Runlist

rFiles and Pac rRunList
= opepdpagecolors pof Crer File: Page
1 1/1 Bpages_ocdnumbered pof 1i
2 2[1 Bpages_oddnumbered pof 1
a 3/1Bpaes L
1 4 |yxpdpagecolors pdf 3
16pages_oddnurmbered pdf a[1Bpages_oddnumBbered.p K
B |1 Bpages_ocdnumbered pof 1.
7|1 Bpages_ocdnumbered pof vl
8|1 Bpages_oddnumbered pof 1.

Figure 1.27 Page replaced
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9 « Check the Separation Style check box (circled below) if you want to override
how colors are separated and output in the RIP’s page feature separation style.
This will expand the Separations list with check boxes for color merging and
color aliasing.

Note: A CMYK Composite "*Separations, Screening and Color" Style cannot

be edited .
& ImposeMate - Untitled
File Edit Help
RunList !Impns'mon- Matks | Preferences
~Filez and Pages | | RunList- -Separations
= s o] Crder  File Page | ||| Colar Separa... Output ToPro... Aliss
1 | 1|oxpdpagecolo... |1 ]
2 2|gxpdpagecolo... |2 B Magerts | [V] [¥] |
3 3oxpdpagecola... |3 el Z Z
4 | I Biack V] V]
(=1 1Epages_oddnumbered pof | Green [+] | =
1 I Red [v] L[]
i
il
1iv
¥
1wl
1wl
1wl
2a
2h
2 _
2d
2e |
Lt >l |l
Cutput
Mame : |3xpdpagecolors_runlist ps Media Size | 2032 %2967 cin
Cwerride + [«] Imposition Page Layout s [ Sedaration Style
ty
€ECRM : e e
imBging Sysiems [5ealing Horizontal | | 2 | 20E ‘% [ |Rotate
[CIRresolution | !dpi [ Frequency i | Ipi
= ]

Figure 1.28 Separations list

When the Separation Style check box is enabled, changes to the Separations list
will be saved in the runlist. Keep the check box disabled if you want to keep
the separation style of the RIP’s page setup. Separation Style uses the output
order of the Page Setup as a default. You can drag colors to re-order the out-
put order.
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10+ You can edit the separation style of the file by mapping, merging or omitting
the colors in the Separations list.

Separations

Caolar Separation Cutput Tao Process Alias
Cyan [#] [#]
N Magerts [V] [v]
ellow [v] [v]
| NEEES [#] [#]
. L]
I R [ |

Cyan

Magenta
Yellow
Black

Red

Figure 1.29 Changing separation style

e Check or uncheck the Output check box for a color. If checked, the color
will be output, if unchecked, the color will not be output.

e Check or uncheck the To Process check box for a color. If checked, the
color will be output as a process color (CMYK). Use this option, if you
want a spot color to be output as a process color. If unchecked, the color
will be output as a spot color on a separation of its own.

e Click a spot color in the Alias field to open a drop-down list with available
alias colors in the file, then map the spot color to another color in the file.

Note: If the separation style used in the Page Setup is set to "Output" other colors, the
spot colors cannot be aliased to another separation!
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11« Check the Imposition check box if you want to override the imposition page
feature previously used in the page setup with a new imposition from the Impo-
sition tab. See “Creating Impositions” on page 35.

Outp'ut .
Mare : [Ipdpagecolors_runiist ps | se : [ Media size V| #2032 % 2967 cm
Crverride Imposition |:| Page Layout size. |:| Separation Style
[]scaling
[ ] Resolution

Haorizontal % ‘ertical | % [ |Raotate

'dpi [ ]Frequency
Figure 1.30 Output section — override imposition

12 « Select a page size from the Use drop-down list in the Output section.
The page sizes listed are available from the PDF file.
Note: You must select the proper setting in the RIP’s Page Setup: PDF Options:
Page Size Bounding Box. Otherwise, the page size in the impososition may not
be correct, resulting in a page size mismatch.

Cutput
Marme | | xpdpagecolors_runlist ps Use i ~ | & 2032% 2967 om
Cwerride : Imposition |:| Page Layout size |:| 5"rp e
[scaling Horizontal % vertic Fieed Size S
= Trim Size
[ ] Resolution dpi [ Frequency Ipi

Figure 1.31 Use page size for output

13 « If page sizes differ or are missing a warning appears in the Output section. Use
mouse over to see details.

Cutput

Mame : |oxpdpagecalors_runlist ps | Use ;| Mediasize v -.=.2D[j}2x29.8? e

Crverride Imposition || Page Layout size [ | Separation Style It Size missing For some pages.
Bleed Size missing for some pages,

|:| Secaling Horizontal | % Wertical | % ATrim Size missing Far same pages.
. Media Size differs hetween nanes.
[ ] Resolution dpi [ ]Frequency Ipi

Figure 1.32 Page size warning

14 - The Name field in the Output sections suggests a name for the runlist file.
Keep the name or save the runlist under a different name.
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15« Select the Save RunList command from the File menu, or click the Save button
in the Output section.
This opens the Save dialog.

Save in: ‘@ Div PS_PDF filer V‘ I ,7|E|E
LY T 1MASCreens-2 ps "8 OXP4PageColors s
uﬁ "Ea| 2MALocSer p "B TechsSpecOddiutmbers ps
Wy Recent "Ea| 3MADOtGEIN P

Documents S5 7 irtift ps

Ea| BAS+LSHr+z ps

i A5 med ekstrem bleed ps
E Ch 4-CreateMontage ps
Tl Ch5-AssemblePages ps
TEa| CMYl+4 s

TEa| Copyradn ps

=

Desktop

¥

E CreatCopyr ps

My Docurments
=
—————— |Ea ferrarinew frort.ps

=
& ferrarips

@

=
1| ParaplyPige ps
My Computer E ParaplyPige2 ps
"Ea| PMColorsdpad ps

ety Metwork

Places Files of type;  [postSicript Fies () v [_cancar |

File name:

Figure 1.33 Save Runlist file

16 « Keep the suggested file name or save the Runlist under another descriptive
name.

17 « Browse to save the Runlist PostScript file in a folder of your own choice.
Otherwise the file will be saved in the folder you have last browsed.

Note: Do not change the location of the PDF files used in the Runlist after you have
saved the Runlist file. Otherwise you will not be able to output the Runlist file. This
is due to the fact that the Runlist uses an absolute path as seen from the RIP.
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Creating Impositions

From the Imposition tab you determine the geometry of your imposition page feature

by selecting an imposition type from the Type drop-down list.

Type

Page Size

Creep

Runlist | Imposition

Type :
Gripper at ¢
‘Work Style ;

Binding Skyle :

Page Size ¢
Tolerance :
Anchor :
‘width
Height : L

® Offset ;
¥ Offset ;|

Bleed : |

Amount ;|

Direction ;

ECRM’

imaging systems

File Edit Imposition Help

Marks

Preferences

M x N Imposition

|top
:Nune

Mone

[ Lock Page Size

Custom
0,07 |

fC‘enter

11.69 |

0,00

0.00

0.16

5,00 |

inch

inch
inch
inch
inch

inch

| inch

Layout

Height: Auto Rotate

12,47 inch Optimize Margins Center Imposition

Freview..,

These buttons are for turning the

page(s) 90 degrees clockwise or

Your choice of imposition type will enable or disable additional drop-down lists in
the Type section, and enable or disable entries in the Page Size and Creep sections.
The Layout section will reflect the selections made in the other sections, see also

counterclockwise. B

Figure 1.34 Imposition tab:

“Layout section N x N Imposition” on page 44.

Note: All page positions and rotation must be done within the imposition. DO NOT
use the Rotation function in Page setup. Pages will be clipped and incorrectly posi-

tioned.
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IMPORTANT: The imposition types N x N Imposition and Step’n Repeat only work
with PDF files. Fill Row, Fill Column and Fill Film work with PDF and PostScript
files.

The various imposition types are described in detail in the sections:
» “Imposition type N x N Imposition” on page 36
* “Imposition type Step’n Repeat” on page 53

* “Imposition types Fill Row, Column or Film” on page 61.

Imposition type N x N Imposition

When you select the "n-up" imposition type N x N Imposition you can create imposi-
tion page features for a variety of jobs while including work and binding styles, if
required.

To create a "n-up" N x N imposition:

1+ Select N x N Imposition from the Type drop-down list.

Figure 1.35 Type drop-down list

2 « In the Gripper at: window, select the side the gripper edge is on.

3« Select a Work Style from the Work Style drop-down list.
When selecting a particular work style you choose the way a press sheet is han-
dled in the printing press. For more details, see “Work styles” on page 10.
You can choose between:
*  None - covers no particular work style, each flat has the same page order
e Sheetwise — each flat has a different page order, i.e. front and back are
imposed differently.
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e Perfector — each flat has a different page order, i.e. front and back are
imposed differently and the back is turned 180 degrees compared to Sheet-
wise.

e Custom - page placement on the flat is man-
ual, using no predictable order. When custom
is selected as a work style, the "Binding
Style" drop-down list changes to "Flats:"

(Re-Inumber Pages
Impose Pages

Open Wizard ...

Enter the number of flats in the imposition Step all Pages
here. Step single Page
Also, right clicking on the Imposition layout Step Row
opens a drop-down list (figure at right) you Step Column
can use to create a layout which can then be -
modified.

4 « Select a Binding Style from the Binding Style drop-down list.

When selecting a particular binding style you choose the binding style for the
publication in advance. For more details, see “Binding styles” on page 11.
You can choose between:

¢ None (no particular binding style)

e Perfect Bound

e Saddle Stitched

When you select the Perfect Bound or Saddle Stitched binding style you will
also be able to compensate for creep, for more details see the sections “Shin-
gling (creep)” on page 12 and “Creep section N x N Imposition” on page 43.

Also, when the Saddle Stitched binding style is

Rk g Dinky 1 | Second to last Signature
selected, you can access the Dinky :selection

Mot allowed
menu. If your imposition is a 4up or larger, you Second Signature
. . - Second to last Signature
can also access the the Folding Style: selection == [FESIREEEEEIEEL
ask Signature
menu shown at the right to select the Fold then (Cuskom

Stack or the Stack then Fold folding style.
Folding Style : | Stack then Fold

. |Fold then Stack.
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Page Size section N x N Imposition

Be

Select a page size from the Page Size drop-down list.

»  Select Custom to create a custom size by entering the size in the Width
and Height fields of the Page Size section

e Select Predefined page sizes (A0, Al, A2 etc.) from the list of available
page sizes

Note: Opening a PDF file or runlist, or checking override imposition (RunList
Tab), or selecting a Value in use: (RunList Tab) will change the page size values
in the Imposition Tab to match the PDF file in the runlist!

TIP: The RIP offers several PDF options to control page placement. When
using ImposeMate’s N x N Imposition or Step’n Repeat imposition, you will
often need to select the TrimBox option from the Page Size bounding box drop-
down list, which is located in the RIP’s Edit Page Setup dialog’s PDF Options
dialog.

Note: If you generate PDF files from QuarkXPress on a Macintosh, do not use
the Save as PDF option, which will use the page size from the printer, but save
as PostScript first and then use a distiller, for example PDFMate, to create the

PDF file. InDesign, on the other hand, will create PDF files with valid page size
information, such as trim box size. If you use other applications to create PDF

files, please check the resulting PDF files for valid page size information.

If you want to lock the imposition page size,

check the Lock Page Size checkbox box (see | "™ o

figure at the right). Doing this will force the e —

imposition to always use the specified page o :

size. Anchor : :Top Left . v
wickhs [ 21,59 cm .

Enter a Tolerance value.

This setting applies to impositions with mixed page sizes. If the second page in
a runlist (see “Creating RunLists” on page 22) is bigger than the first page and
the difference in page size (width or height) exceeds the value in the Tolerance
field the imposition job will error.
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You can set the value as required. The first page in the runlist is the reference
page. This means that if page 1 in the runlist is size A4, page 2 can be size A5,
but not size A3, because this size will exceed the Tolerance value in reference
to page 1.

Note: This feature can disabled using the "Page size mismatch" feature in the
Preferences tab.

Specify an Anchor point for the pages.

The Anchor at; parameter lets
you choose how to anchor pages
in the imposition. This is impor-
tant for controlling pages that
are not exactly the same size as Window Window | |Height
the "window" in the imposition.

1 Width |

Anchoring occurs in the imposi-
tion window (the area reserved
for containing a page in the )
imposition). The imposition Window Window
window’s height and width are
defined by the Height: and
Width: Page Size settings. Using
the Anchor feature, you select one of nine locations in the imposition window
as an anchor point for the page the window will contain.
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The anchor point choices are
Top Left, Top Center, and
Top Right; Bottom Left, Bot-
tom Center, and Bottom
Right; and Center Left, Cen-
ter, and Center Right.

In the choices, top, bottom,
left, right and center are
ALWAY S with respect to
the head of the page. This is
important to remember when
looking at page displays in

LEFT

Window

\M!duw

Window

Window

TOP

CENTER

BOTTOM

RIGHT

both the FolderWizard and the Page Layout window. Both use a dog-eared cor-
ner to represent the head of the page. However, in the FolderWizard the dog-
eared corner rotates to a new orientation in each new view, whereas in the Page
Layout display it is always displayed the same way, with the dog-ear in the

upper right corner.
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Anchor Examples

The figure at the right
shows a 4 x 4 imposi-
tion with Anchor:
selected for Center
Left.

This selection causes
every page in the
imposition to be
anchored center left
in its imposition win-
dow.

The figure below
shows a ViewMate

preview of what our 4 x 4 center-left imposition will look after being printed.

We added the dashed lines and italic text to help you see the imposition win-

dows and to emphasize the head orientation of the pages.
v x|

T [k en Mo

ot fra

[T Whork s T Wikl Tismable

L3

abed Jo pesH
"Head of Page™

1
1
F]

€3 [
s = = Fem— m— = Eem— = =, B e
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The next figure repeats the imposition in the preceding figure and shows how
the same imposition would look for three other anchor selections.

—— - ——n

Frr=

Head of Page 1!

1
1
1
1
1
1
1
1
1
abed Jo peaH_1_abed Jo peaH I
1
: 1
B i !
) 1
1
1
1
1
1

e -y —mmslnm e == = =d

Center

1 a6 J0 peaH_1_3D

Heag of Page

|.: %IJ ‘
| i J 1
m E

e |

Top Right
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2+ Addan X or Y offset to the selected page size.
Page offsets are useful, if all pages in the layout need to be adjusted to allow
more margin for e.g. a spiral bound book or if the document size defined in the
application is different from the required final trim size (= finished size of the
printed document).

TIP: Offset values can be found in the RIP log as the first numbers in the Trim-
Box [ x,y ...] array for the PDF file.

3+ Add a bleed to the selected page size.
The bleed area is added to all four sides of each page and prints beyond the
edge of the finished page.
Note: Bleed will only bleed into the gutters. If the gutter is 0, there will be no
bleed.

Creep section N x N Imposition

4 « Enter an amount of shingling in the Creep section.
The Creep section offers shingling to compensate for creep and applies to the
Perfect bound or Saddle stitched binding method.

Creep occurs when imposed signatures are folded and the image area of the
inside pages extends beyond the image area of the outside pages. The amount
of creep depends on the number of folds and the paper thickness used. Shin-
gling is the process of moving the image area to compensate for the creep. See
also “Shingling (creep)” on page 12.

In the ImposeMate Creep section’s Amount field you specify how much you
want to move the image area in the direction you select from the Direction
drop-down list.
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The specified shingling amount is the distance between the outermost page and
the innermost page:

page
Outermost
page

N

Shingling
7 amount

Figure 1.36 Shingling amount

The following may serve as a guideline to determine the amount of shingling:
divide total pages in the signature by 4, then multiply that number by the thick-
ness of the paper.

e If you select the direction Away from Center you move the image area on
the pages within each signature from the innermost pages (Center) and
outwards to the outermost pages, i.e. away from the binding.

e If you select the direction Towards Center you move the image area on the
pages within each signature from the outermost pages and inwards to the
innermost pages, i.e. towards the binding.

Layout section N x N Imposition

When you select the imposition type N x N Imposition the Layout section
reflects this choice in the display of pages. In the Layout section you also deter-
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mine the "n-up" size, the page numbering, the rotation, and the gutter size of

your N x N imposition.

-@ ImposeMate Standalone -
File Edit Imposition Help

RunList | Imposition | Marks | Preferences
| Type - Layout

Type & [N x N Impasition E

Gripper ot : [top |
Work Skyle ¢ é,-Nﬂf',E, >l

Binding Style ¢ |None v| | s6.69 %
?

Page Size =
8,69
[] Lock Pags Size -
Fage Size : |Ad er | 56.69
Tolerance : [ SEIU point
Bincher : | Center ~|
wikh: | 595,28 paint

Height : l 842‘007 point

ECRM

imaging systems

% Offset ¢ 0.00 | poink =S
Y Offset ;| 0,00/ point !- |
EBleed : | 11,34 | point .
z R
S . i Height: Auta Rotate
Arnourt ¢ 10| point 3,594.77
g point Opkirmize Margins
Direction : T

‘Width: 2,607,589 point

1N |
[¢][® Drag

Center Imposition

Figure 1.37 Layout for N x N Imposition

5« Determine the size of the imposition.

CIEX

Click one of the small rectangular handles positioned on the left and bottom of
the imposition and drag to resize to 2-up, 4-up, 8-up or 16-up impositions.
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6 « Enter a left, right, top and bottom margin in the margin entry fields (if you dis-
able the Optimize Margins function).

Gutter entries lMedia width
Margin L it 1840 o Margin
left \ zo0| zoo| zoo| zoo| zoo| zoo| zoo / right
Margin —» ) 4 Click to select
top J 15 ] column

R
o
=]

5 o oy

o

Gutter a0 J
entries J
oo

2
Click to 4%
select row 200

al| e o
b b =
1
s}

ki

Pages can be
automatically
numbered and
rotated

o

ﬂ--
E--

X
wn
o

2.00 (Re-Jnumber Pages

5]

Irmpose Pages

o
&

Open Wizard ...

200

w
X

o o - o

.
n
w

=
ol
I
It

@

Mal’gil’l /Height: [¥] Auto Retate [:J \ Drag handle
[

bottom/v 2B E Optitmize Margins Certer Pages to resize
Media height ~ Show: Fret hd layout

Figure 1.38 Layout for N x N Imposition: options

7« Enter a horizontal and vertical gutter width in the gutter entry fields.
The gutter width is the distance between the pages vertically and horizontally.

8 » Rotate pages manually as required.
You can select and rotate a page, a row or a column of pages 90 degrees clock-
wise or counter clockwise using the Turn Page commands in the Edit menu, see
“Edit menu” on page 20.

If you work with Auto Rotate enabled, remaining pages, rows or columns of
pages will rotate automatically according to the top-left page. Alternately, con-
trol-click more pages, rows or columns and rotate them in one go. To select a
row or column point to the small rectangular field next to the row or column.
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Qe

10 -

11

12 -

Keep the Auto Rotate check box enabled if you want ImposeMate to automati-
cally rotate pages.

Determine page numbers and page order either by writing a number in each
page or using one of the numbering functions.

Right-click (ctrl-click on a Mac) in T ——

the Layout section and a numbering Impose Pages

menu with the (Re-)Number Pages, | Open Wizard ...

Impose Pages and Open Wizard

commands appears.

Note: Order is critical. Work style
and Binding style must be selected
before selecting a page numbering
scheme. The numbering scheme uses
these selections to determine the numbering sequence.

Figure 1.39 Layout numbering menu

Select (Re-)Number Pages to number all pages consecutively.
This is useful for step and repeat jobs.

Select Impose Pages for imposition jobs and all pages are automatically filled
with valid page numbers.

With Auto Rotate enabled the pages will also rotate automatically to the proper
orientation relative to the top left page while numbered. Impose Pages numbers
work for 1x1,1x2,2x2,2x4,4x4,4x8and 8 x 8 impositions.

When you select Sheetwise or Perfector as work style and use the Impose pages
function the page order and page orientation will be automatically created to fit
the selected work style.

Note: If you print a 16 page PDF file using an imposition page feature with a
saddle stitched 4-up imposition, then the imposition page feature itself will
automatically generate the second signature and renumber the pages on the first
signature. Be aware of what happens if you print a file that does not contain 8,
16, 24, 32 ... pages. In that case the last signature will contain blank pages,
which may not be what you want (sometimes you want the middle signature to
be different).
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13 « Select Open Wizard to open the WorkMates FolderWizard.
This utility will assist you in folding and number "n-up" imposition jobs. See
“WorkMates FolderWizard” on page 49 for more details.

14 « Keep the Optimize Margins check box enabled to automatically make sure that
there is room enough for impaosition marks and additional macro-based imposi-
tion marks.

See “Adding Marks” on page 66 for details.

15« Keep the Center Imposition check box enabled if you want ImposeMate to
automatically center pages around a center punch.

For example, if you add a left-aligned annotation mark, which takes up 5.08
mm margin space to the left, ImposeMate will automatically center pages by
adding another 5.08 mm space to the right margin. The function works for both
horizontal and vertical margins.

Show Front or Back

16 « When you select N x N Imposition and the work style Sheetwise or Perfector
you also have the option of showing either Front or Back of the signature.
When you select Custom work style, the selection is used to show each flat.

17 « Save the finished N x N Imposition page feature. If editing an existing imposi-
tion, use Save Imposition to save changes.
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WorkMates FolderWizard

The WorkMates FolderWizard helps you create and fold a "n-up" imposition layout.

1+ Select the Open Wizard command from (Re-Jnumber Pages
ImposeMate’s Edit menu. | " Impase Pages
Alternatively, press shift-ctrl-N (shift-cmd- | Open wizard ...
N on a Mac) to open the wizard or right-
click (ctrl-click on a Mac) in the Layout sec-
tion to open the numbering menu and then
select Open Wizard:

Figure 1.40 Numbering menu
2 The FolderWizard opens in a separate win-

dow.

The rectangular graphic in the center of the window represents the first page in
a folded imposition dummy. The four buttons surrounding the graphic each
indicate an unfolding direction. The folds determine the page order, and while
unfolding the publication the page numbers are displayed.

& WorkMates FolderWizard

KN

|:| ‘Wark and Turn SWiork and Tumble

[ Redo H Reset H OK H Cancel ]

Figure 1.41 WorkMates FolderWizard

e Select the Work and Turn/Work and Tumble check box if your imposition
will be laid out on one plate. When this option is checked the work style
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will be set to None. See also Chapter 2 « ImposeMate Tutorial for more
details on Work and Turn and Work and Tumble impositions and how they
are printed on the press sheet.

Uncheck the Work and Turn/Work and Tumble check box if your imposi-
tion requires two plates, one for the front and one for the back of a press
sheet. When this option is unchecked the work styles Sheetwise or Perfec-
tor must be used. If None was selected in Work style, it will be changed to
Perfector.

Warning: Do not change the Work and Turn/Work and Tumble setting

after you have started unfolding.

When the wizard is opened, Work and Turn/Work and Tumble is either checked
or unchecked, depending on the Work style setting. Changing the Work and
Turn/Work and Tumble checkbox will change the Work style.

Start folding using the fold buttons.
To unfold and number an ordinary sheetwise 8-up imposition foot to foot, you
click the left (1), bottom (2)and right (3) fold button, in that order.

# Warkiates FalderWizard

=

1 L

Y 2]
=2

[ [ e———,

=

)Wk et Tum st et T

# Warkiates FalderWizard

_ [ 3
S 1<)
=2
[ -

Figure 1.42 Folding a 8-up imposition left to right

«  Note that for publications with the spine to the left of the front page, the

left button will be the first button to press in the FolderWizard. For publi-
cations with the spine to the right of the front page, the right hand button
will be the first to press.

The second button to press will typically be either the top or the bottom
button, resulting in a head-to-head type of imposition or foot-to-foot type
of imposition, respectively.
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< The third button to press will typically be either the left or the right button,
but there are, however, no rules from this point.

Instead of the buttons you can use the keyboard shortcuts Alt-arrow left, Alt-
arrow down and Alt-arrow right to obtain the same folding.

Use the Undo (Ctrl-Z or Cmd-Z on Mac), Redo (Shift-ctrl-Z or Shift-cmd-Z on
Mac) or Reset buttons to adjust the folding, if required.

4 « Click OK when the layout is complete to close the FolderWizard window and
return to the ImposeMate window.

& ImposeMate Standalone - g@@

File Edit Imposition Help

Rurilist | Imposition | Marks | Preferences

Type Layout
P width; 94,36 cm

Type : [N x N Imposition - R . . o = ~

= == | 200 2o 200 | | |

Gripper at ¢ |top e e

work Style : | Sheetwise

S 6] ol |6

Binding Styls  |None

Page Sice
[ Lock Page Size

Page Sizs 1 |Letter ~
Tolerance : | :
anchor ;|
Width: |
Heioht : |

K Offset _
voffset ;|

Bleed: |

Creep Ty
. . Height:
Aot ¢ | | em 59,58 cm

Direction : Show : ‘ "._‘
ECRM

imaging systems

Figure 1.43 ImposeMate 8-up layout — front

WorkMates ImposeMate User Manual, AG50663 Rev. 11 51



Chapter 1 « Using ImposeMate
Creating Impositions

The Layout section displays the layout you created. In this case the Work and
Turn/Work and Tumble check box was disabled and the FolderWizard created
an 8-up imposition layout with front and back.

@ ImposeMate Standalone -

Type

Page Size

Creep

| R,L”?!-is'{j Irnposition | Martks

Type :
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‘Work Style :

Binding Style ; ‘

Page Size :
Tolerance !
Anchor
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¥ Offset s |

Blesd: |
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Direction :

ECRM

imaging systems

File Edit Imposition Help

TN x W Imposition
top

Sheetwise

[[]Lock Page Size

Letter

Preferences

= 018 | am

| Top Left

[ em|m

Layout
i_ ] 200| 200] 200|

‘D,

--_i

Optimize Margins
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Figure 1.44 ImposeMate 8-up layout — back
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5« The FolderWizard displays ’portraitwise.” Use the Turn Sheet commands from
the Edit menu to rotate the sheet, if required.

& ImposeMate Standalone - EIEJ@

File Edt Imposition Help

Runlist | Imposition | Marks || Preferences

Type Layout
p 1 width: 47,18 cm
Type ¢ |Mx M Imposition v — oo =
= = 2,00 =
Gripper at : |top V| ‘ - =
werk Style ¢ | sheetwise | 3
Binding Skyle : f}\lone vl
Page Size
[ Lock Page Size
Page Size ¢ ietter -~
Tolerance : | 018 am -
- — | =
Anchor ¢ | Top Left v| 5

Wlirlbh 21 80 re

Figure 1.45 ImposeMate 8-up layout — Turn Sheet CW

ImposeMate can handle the imposition of a dinky. (A dinky occurs when the page
count does not "fill" the imposition. Typically, a Dinky is one-half of a signature.)

To enable the imposition of a dinky, first select
either the "Perfect Bound" or the "Saddle
Stitched " Binding style, and then a Folding style

Dinky ¢ | 3econd to lask Signature | w

ok allowed
Second Signature

of "Stack then fold". Then select the Dinky S Second ko last Signature
placement (see the figure at the right). If a posi- Lask Signature

tion is desired that is not offered in the popup Custom

menu, select "Custom" and specify the signature. [ Dinky on right sids

Note: The Dinky on right side checkbox , alter-
nates the side of the signature where the dinky is placed.

Imposition type Step’n Repeat

When you select Step’n Repeat the Page Order pop-up list becomes available along
with entry fields for the required horizontal and vertical steps. The entries of the Page
Size section are also fully available.
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To create a Step’n Repeat imposition:

Type section Step’n Repeat
1+ Select Step’n Repeat from the Type drop-down list.

2« Select page order.

@ ImposeMate Standalone - g@@

File Edit Imposition Help

| Runlist | Imposition | Marks | Preferences |
Type

Layaut
— - Width: 23,59 cm
: | Step'n Repeat & 5 :

l:hor. by |
[z

Page Size

[] Lock Page Size

Page Siee ¢ |Letter w

Talerance : | 0.18] am

ST
==

IHEBU &
IEEEE E

ancher ;| Tap Left - |

I
«Q
c
=
@
[
N
[op}

If you select...

Step all Pages- you can use any number of PDF files in your step and repeat
job. Use the RunList editor to define the sequence of the PDF files. See “Creat-
ing RunLists” on page 22 for more information.

Step single Page - you can use a single page PDF file (or only the first page of
the PDF file) only in your step and repeat job. This page will be stepped and
repeated as defined in the horizontal and vertical step entry fields.

Step Row - you can define a row of pages and it will be repeated down the
page. Use the RunList editor to define the sequence of the PDF files. See “Cre-
ating RunLists” on page 22 for more information.

Step Column - you can define a column of pages and it will be repeated across.
the page. Use the RunL.ist editor to define the sequence of the PDF files. See
“Creating RunLists” on page 22 for more information.

Fill in the Step entry fields for the required horizontal and vertical pages in the
imposition.
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Page Size section Step’n Repeat

1e

Select a page size from the Page Size drop-down list.

e Custom to create a custom size by entering the size in the Width and
Height fields of the Page Size section

e Predefined page sizes (A0, Al, A2 etc.) from the list of available page
sizes

TIP: The RIP offers several PDF options to place pages. When using Impose-
Mate’s N x N Imposition or Step’n Repeat imposition types you will often need
to select the TrimBox option from the Page Size bounding box drop-down list,
which is located in the RIP’s Edit Page Setup dialog’s PDF Options dialog.

Note: If you generate PDF files from QuarkXPress on a Macintosh, do not use
the Save as PDF option, which will use the page size from the printer, but save
as PostScript first and then use a distiller, for example PDFMate, to create the

PDF file. InDesign, on the other hand, will create PDF files with valid page size
information, such as trim box size. If you use other applications to create PDF
files, please check the resulting PDF files for valid page size information.

Enter a Tolerance value.

This setting applies to impositions with mixed page sizes. If the second page in
a runlist is bigger than the first page and the difference in page size (width or
height) exceeds the value in the Tolerance field the imposition job will error.

You can set the value as required. The first page in the runlist is the reference
page. This means that if page 1 in the runlist is size A4, page 2 can be size A5,
but not size A3, because this size will exceed the Tolerance value in reference
to page 1.

Note: This feature can be enabled or disabled. See "Page Size Mismatch" in the
Preferences tab.

Enter an Anchor value.

This setting specifies how to place the page in the imposition. Options include
Top Left, Top Center, Top Right, Center Left, Center, Center Right, Bottom
Left, Bottom Center, and Bottom Right.
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4

Add an X or Y offset to the selected page size.

Page offsets are useful, if all pages in the layout need to be adjusted to allow
more margin for e.g. a spiral bound book or if the document size defined in the
application is different from the required final trim size (= finished size of the
printed document).

TIP: Offset values can be found in the RIP log as the first numbers in the Trim-
Box [ x,y ...] array for the PDF file.

Add a bleed to the selected page size.

The bleed area is added to all four sides of each page and prints beyond the
edge of the finished page. (Bleed will only bleed into the gutters. If the gutters
are set to zero (0), there will be no bleed.)
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Layout section Step’N Repeat

When you select the imposition type Step’n Repeat the Layout section reflects
the entered horizontal and vertical steps in the display of pages. It also reflects
whether you step a single page, several pages, rows or columns.

@ ImposeMate Standalone -
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Figure 1.49 Layout Step’n Repeat Rows
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Figure 1.50 Layout Step’n Repeat Columns
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6 « Enter a left, right, top and bottom margin in the margin entry fields (if you dis-

able the Optimize Margins function).

Gutter entries Media width

<4—

. Marai
:\élfzirgln Layaut zlo - / rigz’:\hrtgln
Margin — o

200
Gutter / il
entries

-3

--H--B

-o -o -o -o

=]
B B B B --- [X)
-o -o -o -o

- - - - H =TT B -
-o -o -o -o

Margin/vH

eight:
bottom

380.4 cm

= (¢
(@)

Optirnize Margins Certer Pages

Media height

Figure 1.51 Layout for Step’n Repeat: options

Enter a horizontal and vertical gutter width in the gutter entry fields.

The gutter width is the distance between the pages vertically and horizontally.
In a Step’n Repeat job you only need to enter one vertical and one horizontal
gutter value.

Rotate pages manually as required.
You can select and rotate all pages 90 degrees clockwise or counter clockwise
using the Turn commands in the Edit menu, see “Edit menu” on page 20.

Auto Rotate is always enabled (cannot be disabled), and all pages will rotate
automatically according to the top-left page.
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9« Keep the Optimize Margins check box enabled to automatically make sure that
there is room enough for imposition marks and additional macro-based imposi-
tion marks.

See “Adding Marks” on page 66 for details.

10+ Keep the Center Imposition check box enabled if you want ImposeMate to
automatically center pages around a center punch.

For example, if you add a left-aligned annotation mark, which takes up 5.08
mm margin space to the left, ImposeMate will automatically center pages by
adding another 5.08 mm space to the right margin. The function works for both
horizontal and vertical margins.

11 - Save the finished Step’n Repeat page feature.

Imposition types Fill Row, Column or Film

When you select the imposition types Fill Row, Fill Column or Fill Film you deter-
mine the page order in your imposition page feature from the Page Order drop-down
list.

TIP: The RIP offers several PDF options to control page sizes. When using Impose-
Mate’s Fill Row, Fill Column or Fill Film imposition types you will often need to
select the MediaBox option from the Page Size bounding box drop-down list, which
is located in the RIP’s Edit Page Setup dialog’s PDF Options dialog.

To create a Fill Row, Fill Column or Fill Film imposition:

Type section Fill...

1+ Select Fill Row, Fill Column or Fill Film from the Type drop-down list.
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2 » Determine the page order in your imposition page feature from the Page Order
drop-down list.

Table 1.1 Page order options Fill...

Fill Row page order Fill Column page order Fill Film page order

|F|ight bo left | |EDHDIT| up Bottarm up from left

Top dovwn fram right
Bottorn up fram right
Left ta right from top
Right to left from top
Left ta right from bottom
Right to left from botbarm

The page order is reflected in the display of pages in the Layout section, for
details see “Layout section Fill...” on page 63.

3« Check the Step single page check box, if you want to step a single page PDF
only.

If you enable the Step single page check box you can use a single page PDF file

only in your step and repeat job.

*  When checked the RIP will step the page using the selected imposition
type. The RIP calculates the number of steps and the distance between the
stepped pages.

* Note that the calculation of the number of steps is based on the MediaBox
size from the actual PDF file. The calculation is not accurate as the RIP
calculates the distance between the pages on-the-fly. The result is that the
RIP can calculate one step (=page) short or too much. One step too much
will result in waste of media (=an extra film) and one step too short in a
blank space on the media.

Page Size section Fill...

1+ The Page Size is pre-defined (From File) and cannot be changed.
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2« Tolerance value. - is pre-defined (From File) and cannot be changed.

3« Bleed is pre-defined (From File) and cannot be changed.

Layout section Fill...

When you select the imposition types Fill Row, Fill Column or Fill Film the
Layout section reflects your selection from the Type and the Page Order drop-

down list.
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Figure 1.54 Layout for Fill Film

Rotate pages using the Turn commands of the Edit menu (only if Auto Rotate is disabled).

Enable/disable the Auto Rotate function.

Note that when Auto Rotate is enabled you cannot manually rotate pages. If you keep Auto
Rotate enabled you allow pages to be auto-rotated in the RIP in order to save film or plate
material. For example, portrait pages in a row may be rotated to landscape pages to save
media.

Note: If you output a job that use Fill... to the RIP’s TIFF device you need to define the
wanted exposure format in the RIP’s Page Setup Manager>Page Setup>Page layout>Page
size.

Save the finished Fill... page feature.
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Viewing the Imposition Thumbnails

This utility allows you to view the imposed flats and pages as thumbnails.

1+ Select the Preview button, or the Open Thumbnail View... command from
ImposeMate’s Edit menu.
Alternatively, press shift-ctrl-U (shift-cmd-U on a Mac) to open the wizard.

A separate Thumbnail View window opens.
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Figure 1.55 Imposition Thumbnail Window

2« Inthe "Show" section, select the radio buttons to choose to view the pages from
the RunList or a set number of pages. Also select the page numbering scheme;

Page number from PDf file, RunList order or from Filename (NewsMate Plus).

3« Use the scroll bar on the right to move forward or backward through flats in
sequential order. As you do, refer to the displayed Flat number(s) to track
which flat(s) are being displayed.
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Printing the Imposition Thumbnails.

1+ Select the Open Thumbnail View... command from ImposeMate’s Edit menu.
2« Select the range of flats and/or pages you want to print.
3+ From the File pull-down, select Print...

4 « Select the printer you want to output to, and then click OK.

Adding Marks

The Marks tab will reflect your choice of imposition type from the Imposition tab.

» When you select the imposition types N x N Imposition or Step’n Repeat you can
add imposition marks and step wedges to be positioned along the edges of the sig-
nature.

For details, see “Adding Imposition Marks and Step Wedges” on page 67 and
“Adding Annotations” on page 72.

« When you select the imposition types Fill Row, Fill Column or Fill Film you can
add page marks and step wedges to be positioned along the edges of the individ-
ual page.

For details, see “Adding Page Marks and Step Wedges” on page 70 and “Adding
Annotations” on page 72.

Note: You cannot add individual page marks from the Marks tab to pages inan N x N
imposition signature or a Step’n Repeat imposition, and you cannot add imposition
page marks from the Marks tab to any of the Fill... impositions.
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Adding Imposition Marks and Step Wedges

From the Marks tab you can add a variety of imposition marks to the imposition
types N x N Imposition and Step’n Repeat, all positioned along the edges of the sig-
nature.

& ImposeMate Standalone - C:ECRM WorkMa
File Edit Imposition Help

=lolx|

RunList | Imposition
Marks and Stepwedge:

Freferences |

Layout

W Crop Marks ¥ Sep. Mames 2 [ s [leiias v I

v Reagister Marks v Job Marne

W Fold Marks ¥ wedges

Fa———

v Center Mark. v Colorbars

-Annotations ] l' d 8 d
[ame I Align I Height Distancel ;-:T] ﬂ

MRS <} [IIIIT3ERIG

| P4 PS5 |
| Im Add Delete i ?
ECRM i ‘ f
iméging systems T

Figure 1.56 Marks tab — imposition marks

Note: You cannot add individual page marks from the Marks tab to pagesinan N x N
imposition signature or a Step’n Repeat imposition.

There are several ways to add imposition marks and step wedges.

WorkMates ImposeMate User Manual, AG50663 Rev. 11 67



Chapter 1 « Using ImposeMate
Adding Marks

To add imposition marks and step wedges:

1e

Right-click (ctrl-click on a Mac) within the Marks and Step Wedges or Layout
section.
This opens the Select All - Select None menu.

Select all
Select None

Figure 1.57 Select All / Select None menu

Click Select All to activate all imposition marks and step wedges, and click
Select None to deselect all imposition marks and step wedges.

Alternatively, use the Select All and Select None commands from the Edit
menu.

Alternatively, check the check boxes for the required marks and step wedges
individually.

Alternatively, click the individual marks and step wedges in the Layout section.
Each mark functions as a button and will — when clicked — be added to or
removed from the imposition.
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The Layout section displays the imposition marks as follows:

Job name

e

..$,.

..$,.

L

ld

8d

b

P4

PS5

Crop ——p | __ .
mark —I

.,$.
Fold Al
mark —» =
Center
mark

.$,.

Register mark

e |

X

Color bar

Separation name

Step
wedges

Figure 1.58 Imposition marks

Note that each displayed imposition mark also functions as a button: click the mark
to add it to the imposition.
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Adding Page Marks and Step Wedges

From the Marks tab you can add a variety of page marks, step wedges, and color bars
to the imposition types Fill Row, Fill Column and Fill Film, all positioned along the
edges of the individual page, which is suited for the Fill... imposition types.

& ImposeMate Standalone - C:\ECRM Wor es 3.1)5W ] 3|
File Edit Imposition Help
RunList | Imposition  Marks I Preferences | Job name
~Marks and Stepwedg, Layout
¥ Crop Marks ¥ Sep. Mames [ [y 7 4 x _ Cri op N ark
¥ Register Marks [V Job Mame ¥
¥ Fold Marks v Wedges I I
o 4 4+
i~ v Colorbars !
~fAnnokations i L d 8 d
Name Align Height | Distance I_ﬂ +ﬂ et R b ¢ k
Short text Top 0,51 0.00 = ~ Registef mar
Long text Top 0,51 0.00 B IL i B
Two lines Top 1.0z 0,00 P4 P5 i‘
ITwo lines vl Add | Delete | K 4}
ECRM' Step wedge ! i
imaging systems ] — e || - e [

Figure 1.59 Marks tab — individual page marks

Note: You cannot add imposition page marks from the Marks tab to any of the Fill...
impositions.

There are several ways to add page marks and step wedges.
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To add page marks and step wedges:

1e

Right-click (ctrl-click on a Mac) within the Marks and Step wedges or Layout
section.
This opens the Select All Select None menu.

Select all
Select None

Figure 1.60 Select All / Select None menu

Click Select All to activate all page marks and step wedges or click Select None
to deselect all page marks and step wedges.

Alternatively, use the Select All and Select None commands from the Edit
menu.

Alternatively, check the check boxes for the required page marks and step
wedges individually.

Alternatively, click the individual page marks and step wedges in the Layout
section.

Each mark functions as a button and will — when clicked — be added to or
removed from the imposition.
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Adding Annotations

The Annotations section offers a number of text annotations that can be added and
positioned on the plate. Annotations are added per media or plate. In addition, you
can download a custom color bar to the RIP and add it as an annotation, see “Down-
loading a custom color bar to the RIP” on page 76.

Table 1.2 Default text annotations

Short text:

Time: <T, File: <F, Separations: <S

Long text:

Time: <T, File: <F, User: <U, Separations: <S, Screening: <0

Two lines:
Time: <T, File: <F, Resolution: <I, Separations: <S, Screening: <0

<cCyan><B<cMagenta><B<cYellow><B<cBlack><B<cAll> Collorset: <C, Outputdevice: <D

To create new text annotations, see “Creating Text Annotations” on page 80.

To add, change, reposition or delete a text annotation:

1+ To add an annotation text to the imposition, select an annotation from the drop-
down list, then click the Add button.
The added text annotations are listed with name, alignment, height and distance
from the media edge to the text annotation.

Annatations

Marne Align Height Distance
Shart text Top 1.02 o0

Twea lines b A Delete

Figure 1.61 Select text annotation
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2+ To change a text annotation, click the annotation in the list then select a new
text annotation from the drop-down list that opens.

Annatations

Marne Align Height Distance
Shart text Top 1.02 [o.0
Long text Top 1.02 0.0
Short ket
Long kext
Ml

Figure 1.62 Change text annotation

3« To reposition a text annotation, click the annotation in the list then select a posi-
tion from the drop-down list that opens.

Annatations

Mame
Short text

Twea lines

Align Height Distance
Top 1.02 0.0
Left 0
Right

Twa lines Battom Delete

Figure 1.63 Position text annotation

WARNING: If you scale a job to which you have added annotations, the anno-

tations will not be scaled.
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Text annotations are positioned on the plate with reading directions as shown

below:
<> Top
Left
o M. /i
ﬁ Annotation
Custom color bar
Right

¥ Bottom

Figure 1.64 Reading directions

Position the text annotations as required for right-reading while handling the
plate. If they are larger than the impaosition, they start on one edge and are
clipped. Custom color bars are positioned centered along the plate edge as
shown above.

See also “Downloading a custom color bar to the RIP” on page 76.
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4o

The 4-up imposition below is created with a Two lines text annotation posi-
tioned at Top and a long custom color bar centered and filling out the bottom
edge.

[N I SN

Figure 1.65 4-up imposition

To redefine an annotation’s distance from the media (plate) edge, select the
annotation in the list, double-click the value in the Distance column, remove the
old value using the backspace key, then enter a new value in the entry field.

The Distance value is the distance from the edge of the bitmap to the edge of
the annotation. You can enter negative values. For example, if you want to posi-
tion two color bars next to each other along the left side of the imposition, you
set the Distance value for the first color bar to "0", then set the Distance value
for the second color bar to the value that is displayed in the Height column for
the first color bar. The Height value is the (estimated) height of the selected
annotation.

To remove a text annotation from the imposition, select the annotation in the
list then click the Delete button.
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Downloading a custom color bar to the RIP

Custom color bars can be downloaded to the RIP for use with ImposeMate. The color
bar file formats may be PostScript (single page only), or EPS (including PC-format
EPS).

ECRM recommends using EPS files (from e.g. Adobe Illustrator) and does not rec-
ommend using color bars on pre-separated work.

Note: Make sure that the color bar has the correct size before you install it. Impose-
Mate centers the color bar and clips it, if it is longer than the media, but ImposeMate
does not repeat the color bar, if it is shorter than the media.

To download a custom color bar:
1+ Open the Page Setup Manager.

2« Click New in the Page Setup Manager window to open the New Page Setup
dialog.

3« Inthe New Page Setup dialog’s Processing section check the Enable Feature
check box and select Install Annotation from the page feature drop-down list.
Leave all other settings as is.

4 « Click on Save As to open the Save Setup dialog.

5« Save the page setup under a descriptive name, for example "Install Annota-
tion". The Page Setup Manager window reappears.

6 Click OK to close the Page Setup Manager window.
7 « Open the Print File dialog.
8« In the Print File file dialog browse for and select the custom color bar file.

9« In the Print File dialog select Install Annotation from the Page Setup drop-
down list.
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10 « Click Print to install the color bar file on the RIP.

The color bar can now be selected from the Annotations drop-down list in Impose-
Mate’s Marks tab.

Note: If ImposeMate was running while you downloaded the color bar you will need
to either restart ImposeMate or use File: > New Run List > New Imposition > Open
File > Open Imposition to make the color bar appear in the Annotations list.

Displaying a color bar’s colors in the Run List tab Separations panel

If you want to display a the colors in a custom color bar in the Run List Tab Separa-
tions panel, do the following:

1+ Make a PDF of the color bar.

2+ Assign the PDF the same name the color bar has in the Annotations List.

3« Put the PDF of the annotation in the .../Workmates/Data/Annotations folder.

4 « Restart ImposeMate.

The figure below shows the Run List tab Separations panel for the same job before
and after a PDF color bar was created and installed as described above..

ECRM

ECRM

BEFORE

AFTER
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Defining Preferences

In the Preferences tab you can define various settings for marks, step wedges, color
bars, and text annotations. Once defined, the settings will affect the marks, step
wedges, color bars, and annotations in the Marks tab.

For details, see:

» “Marks and Step Wedges” on page 79

» *“Color Bars” on page 80

e “Creating Text Annotations” on page 80

e “Macro Overview (text annotations)” on page 85

From the Preferences tab you can also define settings for error handling, OPI, job
title, application settings (units) and device type and conditions for aborting the job.

For details, see:

e “Other Features” on page 82

» “Application Settings” on page 83.
e “Abort Job When” on page 82.
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@ ImposeMate Standalone - Untitled

Clearance

Line Width

Colorbars

Other Features

Crop Size ©

Fant

Font Size :

Fant

Font Size :

Error Handler ;
CPI:
Iob Title

Device Type

File Edit Imposition Help

| RunLit | Impostion | Marko | Prefersnces

Marks and Stepwedges

; DDSJ inch
! 0.00| inch

1000

v
e ¥
|

Mone hel
betar ]
Part Drum vl

ECRM

imaging systems:

Text Annotations

Marme ¢ iShDrthext vH New ][ Delete ]
Time: <T, File: <F, Separations: <8

Macro ;|- v
Parameter : Add

Ahort job when ..,
Number of Pages mismatch
Page Size misrmatch

Layout Size mismatch

Epplication Settings

Units & |inch ¥

| in Gripper at ; |top )

Decirnals | |2 | Rurtist sorting | ‘by Filenarme V‘ Language : EEnghsh ¥

Wiarn about unsaved changes [ Show Titke instead of File Name

[ override Separation Style Warn about clipped annotations
Import Al Files to RunList

Page Size Default: Trim Size

Marks and

Figure 1.66 Preferences tab

Step Wedges

Crop size: Lets you set the distance from the page trim size to the outer edge of the

crop mark.
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Clearance: Lets you set the distance between the page trim size and the beginning of
the mark.

Layout :
Crop size

I @ Flatim L "é"' B, e bisi L3 B B

Clearance

g, . &

™ T
EEg -

Figure 1.67 Crop size and clearance

Line Width: Lets you set the line width of the crop and fold marks.

Font: Lets you select a font for the separation and job name text among the available
fonts on the RIP.

Font Size: Lets you select a font size for the separation and job name text.

Color Bars

Font: Lets you select a font for the color bar text among the available fonts on the
RIP.

Font Size: Lets you select a font size for the color bar text.

Creating Text Annotations

This section lets you create customized text annotations containing typed-in informa-
tion and/or macro-based information. The created text annotations can then be added
to the imposition, see “Adding Annotations” on page 72.

To create a text annotation:
1« Click the New button.

2« In the Name field enter a descriptive name for the text annotation.
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3+ Toadd a macro, select it from the Macro drop-down list then click the Add but-
ton.
See “Macro Overview (text annotations)” on page 85 for details on the macro
codes.
Additionally, you can write your own text in the text field and use it in combi-
nation with the macro text.

Text Annatations

Mame : Short text b =

Time: <T, File: <F, Separations: <3
Customer X¥E

Macra ;|-

Parameter :

==

=4, arti-alissing factor

=B =olid square

= name of the current colorsetup

=D narme of output device

<E the job type (PS, POF, EPS, ..)

=F the name of the jobfile (incl path) b

Figure 1.68 Add macro text

Some of the macros contain optional parameters that must be selected from the
Parameter drop-down list. When added the text macro information is displayed
in the text field by a macro letter which is replaced by text in the RIP.

Text Annatations

Mame : Short text b =

Time: <T, File: <F, Separations: <3
Customer X¥E

Macrao : |=c change colar .

Parameter : |2l b A

Magents
v ellowy

Elack

Figure 1.69 Select macro parameter
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TIP: To check the added macro in the Text field you position the cursor right after the
macro character < and the full macro code is displayed in the Macro list.

Notes:

« Some macros will error if used in unsupported separation style, for example, <0
screening report,when used with a contone separation style.

» The text annotations are by default encoded using ISO Latin 1 Encoding. Charac-
ters unavailable in this character set will not display correctly.

» Keep the Optimize Margins function enabled to let ImposeMate calculate room
for the text macros, or manually add the required margin.

Abort Job When

From the Preferences tab you can define settings that will abort the job if one or more
imposition settings is a mismatch for the submitted job. Three mismatches can be
defined:

» Number of pages mismatch - number of pages in the job does not match the num-
ber of pages in the imposition.

» Page size mismatch - page size of the job is not within the tolerance defined in the
imposition.

» Layout size mismatch - the page size specified in the RIP’s Page Layout is
smaller than the imposition requirements.

Other Features

From the Preferences tab you can define settings for error handling, OPI, and job
title.

Error Handler: Lets you select an error handler, None, Error Handler-Long or Error
Handler-Short, to be used with the imposition page feature. The selected Error Han-
dler information is displayed in the RIP log.

OPI: Lets you select an OPI page feature, enable opi filter or image replacement, to
be used with the imposition page feature.
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Job Title: This pop-up list offers you three
job title choices, as shown at the right.

Other Featuras

Error Handler : | Mone v:
Default - Uses the job title defined in the 0PI+ [Nane ¥
Postcript file. Job Title : _De.F-au-It v
Use Title from job - Uses the "title" string in Device TP | Titk from job
the Postscript file as the job title in the RIP Uéeéa"i\m
Output Controller/Monitor, the RIP View in imaging Systems

WorkMates, and as the Marks- Job Name:

Use file name - Uses the job file name as the job title in the RIP Output Controller/Mon-
itor.

Device Type: Lets you select the device type for your Fill Row, Fill Column or Fill Film
imposition page feature: Capstan, Part Drum, Full Drum, Sheet or File. This setting is
primarily for ECRM engineers and is used in combination with Page Setup in the RIP.

Application Settings

From the Preferences tab you can define settings for units and device type.

Units: Lets you select the preferred measurement units when working with ImposeMate.
Choose between cm, mm, inch or point from the drop-down list.

Decimals: Lets you set the number of decimal places in units.
Gripper at: Lets you set the default setting for the gripper edge.
Checkboxes

Warn about unsaved changes - Check this box if you want ImposeMate to issue a warn-
ing every time you make changes to the run list and try to close without saving the
changes. Leave the box unchecked if you do not want to be so warned.

Hold ouput of page buffers - Check the box to hold the output of the page buffers (useful
for previewing), or leave the box unchecked to immediately output the buffers.

Note: The ""Hold output of page buffers' feature is only available in the ImposeMate
Client program; it is not in the ImposeMate Standalone program.

Language: Lets you choose the language used in the menus and screen messages.

Note: The ""Language’ feature is only available in the ImposeMate Standalone pro-
gram; it is not in the ImposeMate Client program.
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Page Size Default: No Default - - .-
Clicking on the Set Order button o™= ean st

[[] tmpert All Files o Runtist

pU“S dOWn a menu that Iets you Page Size Default: ho Default h Seto(de([ @Fag! Size Default
set the order in which page size i
parameters will be processed. e
Crop See
After you set the order you want, o))

click OK. To effect the new
order, close ImposeMate, and
then reopen it again.
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Macro Overview (text annotations)

There are two types of Macros that can be added to text annotations;

« Text Annotation Macros, These can be used in all systems with ImposMate.

* NewsMate Plus Publication Macros, These can be used in NewsMate Plus.

The code explanations for the Text Annotation Macros are as follows;

Table 1.3 Macro code explanation

CODE MEANING

<< Include a '<' character in the output text.

<A The antialiasing factor which has been applied (‘None' for 1x1, oth-
erwise '2x2', '3x3', and so on).

<B Draw a solid square in the current color.

<C The name of the Color Setup selected on the RIP's Page Setup dia-
log.

<D The name of the output device selected on the RIP's Page Setup dia-
log.

<E The encoding of the job file: PostScript, PDF, EPS, TIFF, or JFIF.

<F The name of the job file (if available), including full path details. If
the job arrived through an input plugin other than SpoolFolder
then this will normally show the input channel name rather than a
file name.

<G Reports the name of the job file in the same way as <F, but does not
include the full path details of the job file.

<H The RIP product name.

<l Output resolution in dots per inch.

<J The job name, or '(Untitled)' if no job name has been set.
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Table 1.3 Macro code explanation (Continued)

CODE MEANING

<K The DescriptiveName of this Exposed Media if the jobwas
submitted through JDF.

The query <?1sJDFMediaName> may be used to determine if this
data is available.

<L The localized time and date.The localization and date format are set
by the operating system control panel. See also <T and <#D.

<M Output resolution in dots per mm.
<N The flat number within the job.
<0 Information about oversized pages or flats. This will draw just a

space if pages were not oversized, '(Clipped) ' if they were clipped
or '(Scale: nn%) if they were scaled. If pages were both clipped and
scaled then both pieces of information are shown. If you wish to
construct the text differently based on whether the file has been
scaled or clipped you can call PageClipped or 1sScaled within
an ”if” command, for example:

<?PageClipped> ... <:<?IsScaled> ... <: ... <II
<P The name of the page setup through which the job was processed.
<Q The name of the profile used in the ColorPro setup selected in the

page setup through which the job was processed.

<R The serial number of the RIP.

<S A list of the separations (colorants) used on the flat, each name will
be shown in the appropriate color.

<T Time and date in standard format. See also <L and <#D.
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CODE

Table 1.3 Macro code explanation (Continued)

MEANING

<U

The name of the user who created the file, if available. Only shown
for PostScript, EPS and PDF files. For PDF files it is the value of the
Author field in the Info dictionary. If you wish to react differently
depending on the availability of this information you can use the
IsUserDefined procedure inan ”if” command: <?IsUser-
Defined> ... <!

<V

RIP version

<Ww

The modification date of the job file, if available. Only available for
PostScript, EPS and PDF files.

<X

Screening report. The current screen name is printed. If relevant, the
screen frequency is also added. The test <?1sContone> may be
used to determine if the RIP is applying any screening.

<SCXXXX>

Draw the following text in the colorant named xxxx. Use <cAl 1> to
switch the RIP back to the standard all-channels color.

<FXXXX>

Draw the following text in font xxxx.

<snn>

Draw the following text at nn points.

<EXXXX>

Use encoding. A new encoding vector is installed in the current font.
The value of the command must be the name of a standard encoding
resource. Note that changing font resets the encoding to the default
encoding for that font. Encoding may only be changed for font types
1, 3, 32,42 and 111 attempts to change the encoding for other font

types will be silently ignored.

<Innn>

Set leading. The leading used when <n (new line) command is used
may be defined as the value of the <I command. If no <1 command
has been used when a <n command is encountered then the leading
will default to 1.2 times the current text size.
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Table 1.3 Macro code explanation (Continued)

MEANING

<n

New line. The current point will be moved to the original X posi-
tion, and the current leading (or 1.2 times the current text size if no
leading has been set) below the Y position of the last line.

<tnn

Horizontal tab. The current point will be moved nn points to the

right of the original X position, without adjusting the Y position.

Note that this can be used to move the current point to the left as

well as to the right, although that would typically cause text to be
overwritten and must be used with extreme care.

<PXXXX>

If. The value xxxx is evaluated as a boolean expression in Post-
Script. If true, the string elements (including commands) following
the <? command will be acted on. If false, control will skip to either
<: (else) or <! (endif) command. If/endif contexts may be nested.

The test 1sOversize may be used with this command to detect
whether the page has been clipped or scaled because it was too
large. For example:

/Text (<#fl<#el<I<?IsOversize><f#2<#el<O<l)

If the job was too large, then text confirming clipping ’(Clipping)’
and scaling details ’(Scale: nn%)’ would be printed after the job
name. See also: o.

Else. This may only follow <? (if) command.

<1

End if. This may only follow <? (if) command, with or without an
intervening <: (else) command.
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Table 1.4 NewsMate Plus Macros

Note: Not all Macros are available at all times.

CODE

MEANING

<Publication>
<Section>
<Edition>
<Revision>
<Page>
<Color>
<Date>
<Time>
<Copy>
<Extension>
<Volume>
<Flat>
<Signature>
<Aux 1>
<Aux 2>
<Aux 3>
<Aux 4>
<Aux 5>
<Aux 6>
<Aux 7>

<Aux 8>

Inserts the Publication Name.
Inserts the Section Name.

Inserts the Edition Name.

Inserts the Revision.

Inserts the Page.

Inserts the Color.

Inserts the Date.

Inserts the Time.

Inserts the Copy count.

Inserts the filename Extension.
Inserts the Volume Name.

Inserts the Flat number.

Inserts the Signature number.
Inserts the Aux1 variable contents.
Inserts the Aux2 variable contents.
Inserts the Aux3 variable contents.
Inserts the Aux4 variable contents.
Inserts the Aux5 variable contents.
Inserts the Aux6 variable contents.
Inserts the Aux7 variable contents.

Inserts the Aux8 variable contents.
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Saving Preferences

To save your preferences, select the Save Preferred Marks command from the File
menu.

Additional Default VValues

Note: The information that follows is for experienced users.

Additional default values can be set manually by editing the ImposeMateDe-
fault.properties file in the .. \ECRM WorkMates 4.1\WorkMates\data folder.

To edit the file: = | ImposeMateDefault. properties - WordPad g@g‘

Flle Edit ¥iew Insert Format Help

D &k s

. A A %Default values for ImposeMate o
2« Open the file in a text editor #Mon Epr 18 10:25:46 EDT 2011

RightGutter=28.3445
(e.g., WordPad on a PC) CenterImposition=true

AutoRotate=true

1+ Make a backup copy of the file.

LeftGutter=28.3465
3« Edit settings. (Values are in TopGutter=28.3465

. BottomGutter=28.3465
points or true/false.) Gutter=5a.a929

OptimizeMargins=true

4 « Save the edited file. For Help, press F 1

Saving an imposition page feature

When you have finished an imposition page feature you save it in the Page Features
folder on the RIP.

Saving an imposition page feature
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When you have finished an imposition page feature you save it in the Page Features
folder on the RIP.

Note: If you save imposition page features in a different folder you will not be able to
see them and print to them.

To save an imposition page feature:

1« Select the Save command from the File menu.
This opens a Save dialog.

2 « Enter a descriptive name for the imposition page feature in the file name field.

3« Click Save.

Opening an imposition page feature

Imposition page features are stored in the Page Features folder on the RIP.

To open an imposition page feature:

1+ Select the Open command from the File menu.
This opens the Select an Existing Page Feature dialog.

2« Select the imposition page feature in question.
3« Click Open.
4 « Make modifications as required.

5« Save the imposition page feature or use the Save as command to save it under a
different name.
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How to create an imposition page feature step by step

Use this instruction as a guide to create your own imposition page features.

To create an imposition page feature:

1e

Open ImposeMate as described in “Starting and exiting ImposeMate” on
page 16.

Select the New command from the File menu.

In the Imposition tab select an imposition type from the Type drop-down list.
At this stage you have already determined what type of imposition is needed for
your publication. See also “Plan your imposition” on page 7 for details.

Depending on imposition type you now specify Page Order, Work Style and
Binding Style.

For details on the options, see:

e “Type section N x N Imposition” on page 35

e “Type section Step’n Repeat” on page 54 or

e “Type section Fill...” on page 61.

Select a page size, define page offsets, if required, and bleed.
For details on the options, see:

e “Page Size section N x N Imposition” on page 38

e “Page Size section Step’n Repeat” on page 55 or

e “Page Size section Fill...” on page 62.

Specify shingling to avoid creep, if required.
The Creep option is available for the Perfect Bound and Saddle Stitched bind-
ing style. For details, see “Creep section N x N Imposition” on page 43.

If you have selected a N x N Imposition you now create the imposition layout
with the required margins, gutters, page numbers, page order and orientation.
For details on the options, see “Layout section N x N Imposition” on page 44.
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10

11

12 -

13-

14«

If you have selected the Step’n Repeat imposition type you can now specify
margins, gutters or rotate pages, if required.
For details on the options, see “Layout section Step’N Repeat” on page 57.

If you have selected the Fill Row/Column/Film imposition types you can now
specify margins and rotate pages, if required.

The imposition layout will follow the specified Page Order. For details on the
options, see “Layout section Fill...” on page 63.

From the Marks tab you select the required imposition marks for the signature.
For details on the options, see “Adding Imposition Marks and Step Wedges” on
page 67.

From the Marks tab you select the required marks for the individual pages.
For details on the options, see “Adding Page Marks and Step Wedges” on
page 70.

Optionally, you may want to change the behavior of the marks from the Prefer-
ences tab.
For details on the options, see “Defining Preferences” on page 78.

Optionally, you may need to include error handling and OPl management with
your imposition page feature.
For details on the options, see “Other Features” on page 82.

Save the imposition page feature as described in “Saving Preferences” on
page 89.

How to use an imposition page feature

To use an imposition page feature:

1e

Create and save the imposition page feature in the Page Features folder on the
RIP.
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Create a new page setup on the RIP that includes the imposition page feature.
See the RIP’s user manual for instructions on how to create a new page setup
and use page features from the Enable Feature list.

Save the new page setup using a descriptive hame.

Open the RIP’s Print File dialog that lets you browse for a PDF file that needs
to be output using the new page setup.

Select a PDF file.

Select the new page setup from the Page Setup list in the Print File dialog and
click Print.

Alternatively, use the new page setup with a spool folder in the Input Control-
ler, see the RIP’s user manual for details on Input Controller and spool folders.

Outputting a Runlist file

The following procedure presupposes that you have already created a page setup with
an imposition template for a particular job. Changes to this job are then saved in a
Runlist file, which is output using the same page setup.

1e

Qe

3e

Open the RIP’s Print File dialog.
Browse for and select the Runlist file.

Select the correct page setup from the Page Setup list in the Print File dialog
and click Print.

See also “How to use an imposition page feature” on page 92 for details on how to
create a page setup using an imposition template and output it.
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Running ImposeMate Client in WorkMates

So far, we have talked about ImposeMate running as a standalone program, outside
the WorkMates environment. In this section, we’ll briefly talk about ImposeMate
Client program, which provides for operating ImposeMate within the WorkMates

environment.

The scope of this section is limited to describing the differences between the Impose-
Mate standalone program and the Workmates ImposeMate Client program. For
instructions for using the ImposeMate Client program, refer to WorkMates User
Guide AG50664, delivered in PDF form on the WorkMates CD.

The table below highlights the main differences between the ImposeMate standalone
program and the ImposeMate Client program.

Table 1.5 ImposeMate (standalone) vs. ImposeMate Client

ImposeMate

ImposeMate Client

Can only use local PDF files on the
local machine.

Can only use PDF files in the workflow
(on the WorkMates Server) from any
client connected to the WorkMates
Server.

Can open PDFs, runlists, and Imposi-
tions from anywhere and save runlists
and Impositions anywhere.

Can only open runlists and PDFs and
save runlists from within the workflow.

Can only open and save Impositions in
the RIP Page Feature folder.

Cannot print directly to RIP.

Can print directly to RIP.

Cannot hold output of page buffers so
job can be viewed in ViewMate prior to
output.

Can hold output of page buffers so job
can be viewed in ViewMate prior to
output.

WorkMates ImposeMate User Manual, AG50663 Rev. 11




Chapter 1 « Using ImposeMate
Running ImposeMate Client in WorkMates

96 WorkMates ImposeMate User Manual, AG50663 Rev. 11



Chapter 2

ImposeMate Tutorial

Introduction

ImposeMate will let you create, edit and output a variety of imposition jobs as
described in Chapter 1  Using ImposeMate.

This tutorial describes how to create some of the most frequently used imposition
layouts.

e “Work and Turn using one plate” on page 98

e “Work and Tumble using one plate” on page 101.
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Work and Turn using one plate

The economical Work and Turn imposition layout uses a single plate (for each color)
to print both sides of the press sheet. After the first side of the press sheet is printed,
the paper is flipped over side-to-side and printed again on the other side using the
same plate. The gripper edge remains the same.

If your job contains 8 pages and the press sheet supports 8 pages you can arrange all
8 pages on one plate. The pages for what would normally be the front are laid out on
one half of the plate and the pages that would normally be the back are laid out on the
other half of the plate. The pages need to be carefully imposed so that when the press
sheet is flipped, page 2 prints on the back of page 1 and page 1 prints on the back of
page 2.

Y
i 1 Flip over

Cut
| |
. .I side-to-side
]
k i

m]

it ., ¥ b, L, *
= [ ]

1] u]
— — r— —

Gripper edge

Figure 2.1 Work and Turn Press Sheet

After printing the sheets are cut in half to double the quantity of sheets. A job that
would have required 1,000 sheets when printed sheetwise, front and back with two
plates, now only requires 500 sheets, thus saving material and make-ready time
(same plate and no plate change).

To create a Work and Turn layout in ImposeMate:
1« Prepare an imposition dummy in advance

2+ On the Imposition Tab page, select New Imposition from the File pull-down
menu.
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3+ Select N x N Imposition as imposition type.

4 « Select None as Work Style.

5« Select Binding Style as required by the binder.

6 « Define settings in the Page Size section as required.

7 » Chose one of the following:
» To use FolderWizard to lay out the imposition, continue with step 8.
e To manually lay out the imposition, continue with step 10.

Using the FolderWizard to Create the Layout

8 ¢ Open the FolderWizard.
Press the buttons (sequence

S . @ WorkMates Folderizargg x
1, 2, 3). This will define the - L
number of pages, while
numbering and rotating the : e i
pages. Then click OK to
1 3 (3
return to the ImposeMate Q L -
Layout section to see the > B 5 g)
result.
3 1|2 7
Note that for publications
with the spine to the left of gJ |
the front page, the left button
W|” be the fil’St button tO v swork and Turn | Work and Tumble
press in the FolderWizard. undo | cets | messt [[ ok | comcel |

For publications with the
spine to the right of the front
page, the right hand button
will be the first to press.

Figure 2.2 Work and Turn folding scheme

The second button to press will typically be either the top or the bottom button,
resulting in a head-to-head type of imposition or foot-to-foot type of imposi-
tion, respectively.
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The third button to press will typically be either the left or the right button, but
there are, however, no rules from this point.

9 « Save the imposition under a descriptive name. You are finished.
Note: Impositions are saved in the RIP’s \SW\Page Features folder (See Figure
1.13 on page 19).

Maually Creating the Laying Out
10 « Define number of pages (8) in the Layout section (drag to resize).
11 « Number the pages manually according to your dummy.

12 « Rotate pages as required (head to head in this example).

@& ImposeMate Standalone - Untitled B =]
File Edit Impositon Help

Runtist  Imposition | Marks | Preferences |
Typ | [ Layout

width: 22,00 e |
100 [ ZUUI ZUU! zuu| 4IJU| 2.0 | 4[JU| zoo [ 1.00
.

AR BN N Imposition

Gripper at : [Eop - i |
wwm——ir_lﬁlallll
Binding Style : [None = Z. 00y
7
~Page Size- 1| [Zom 4
Page Size : [Ad =
Zo0
Talerance : 0.8 an
z
anchor : [Top Left = || [zm
Z00
Haight ¢ 29.70 cm 20 " N
—
% Offsat ; 000 om [Zm
zo0
voftet: [ om
Bleed : 0,40 tm 2005 3 % X
M - DREE0E
Creep- | e -
Amount : aon em | Hights [7 Auto Rotate el 9|
Direction : [nay fram Canter 7] ||39S™ & Optimize Marains [V Center Impostion

ECRM

imaging systems

Figure 2.3 Work and Turn Layout

13 « Save the imposition under a descriptive name. You are finished.
Note: Impositions are saved in the RIP’s \SW\Page Features folder (See Figure
1.13 on page 19).
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Work and Tumble using one plate

The economical Work and Tumble imposition layout uses a single plate (for each
color) to print both sides of the press sheet. After the first side of the press sheet is
printed, the paper is flipped from top to bottom and printed again on the other side
using the same plate. The gripper edge changes ends.

If your job contains 8 pages and the press sheet supports 8 pages you can arrange all
8 pages on one plate. The pages for what would normally be the front are laid out on
one half of the plate and the pages that would normally be the back are laid out on the
other half of the plate. The pages need to be carefully imposed so that when the press
sheet is flipped, page 2 prints on the back of page 1 and page 1 prints on the back of
page 2.

After printing the sheets are cut
in half to double the quantity of
sheets. A job that would have

|

Flip from
top-to-bottom

o
nﬂ
P
A

required 1,000 sheets when

pr.mted sheetwise, front and back Cut + b s 4,
with two plates, now only [
requires 500 sheets, thus saving | 9

material and make-ready time B E

(same plate and no plate change). i E ot

To create a Work and Tumble Gripper edge

layout in ImposeMate: Figure 2.4 Work and Tumble

1+ Prepare an imposition dummy in advance.

2+ On the Imposition Tab page, select New Imposition from the File pull-down
menu.

3« Select N x N Imposition as impaosition type.

4 « Select None as Work Style.
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5« Select Binding Style as required by the binder.

6 ¢ Chose one of the following:
» To use the FolderWizard to lay out the imposition, continue with step 7.
* To manually lay out the imposition, continue with step 9.

Using the FolderWizard to Create the Layout

7 » Open the FolderWizard.
Press the buttons (sequence 1, 2, 3). This will define the number of pages, while
numbering the pages. Then click OK to return to the ImposeMate Layout sec-
tion to see the result.

il & WorkMates FoIderWi'zéé

¥ Work and Turn { Work and Tumble

Unda | Redo | Reset | [8]4 I Cancel |
T—oF = T "

[l )

Figure 2.5 Work and Tumble folding scheme

Note that for publications with the spine to the left of the front page, the left
button will be the first button to press in the FolderWizard. For publications
with the spine to the right of the front page, the right hand button will be the
first to press.

The second button to press will typically be either the top or the bottom button,
resulting in a head-to-head type of imposition or foot-to-foot type of imposi-
tion, respectively.
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The third button to press will typically be either the bottom or the top button,

but there are, however, no rules from this point.

8« Save the imposition under a descriptive name.

Note: Impositions are saved in the RIP’s \SW\Page Features folder (See Figure
1.13 on page 19).

Maually Creating the Laying Out

9 « Define number of pages (8) in the Layout section (drag to resize).

10 « Number the pages manually according to your dummy.

11 - Rotate pages and turn sheet as required (rotate head to head in this example).

& TmposeMate Standalone - Untitled
File Edit Imposiion Help

Type-

Type ©
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Work Style :
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0o =
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Figure 2.6 Work and Tumble layout

12 « Save the imposition under a descriptive name.
Note: Impositions are saved in the RIP’s \SW\Page Features folder (See Figure

1.13 on page 19).
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ImposeMate Help
running 94
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